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Account Registration 

 

1. To begin using the base module, create an account with Leviton. 

2. Open any web browser and type levitonbmo.com into the URL box and press enter. 

This will direct you to the Building Manager Online 3.0 login screen. 

3. To create an account, click Sign Up Here. This will direct you to the User Registration page. 
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4. Enter all information in fields. 
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5. Read and agree to the terms of use and click REGISTER.  

 

The registration confirmation screen is displayed. 

 

 

6. Click the link to return to the login screen. 
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Account Login 
1. Enter your username and password and then click LOGIN. 

 

This is the home screen of the Building Manager Online 3.0. This is also known as the base 

module. The base module is available at no cost and allows you to:  

a. Create groups 

b. Add hubs/meters to Groups 

c. Export energy usage data 

d. Display energy usage graphs 
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Base Modules 

Base Module: Adding Meters 
1. Click Wizards. 

2. Click Add a HUB. 

 

a. NOTE: You can also add the initial hub by clicking/pressing the Add new hub button 

located in the System Network. 
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The Add a HUB wizard is displayed. 

 

3. Enter the HUB serial number. 

a. The serial number for the Flex IO module or HD Pulse module is located on the sticker 

on the back of the device. 

b. To access the serial number for an embedded Hub or embedded HubLite, press the 

menu button, select data upload, then select show serial number. The serial number will 

appear on the LCD screen. 

c. To access the serial number for an EMH Hub, remove the lid. The serial number is 

located on the label on the Ethernet port. 

d. To access the serial number for an EMH+, touch the about icon and scroll down. The 

serial number will be displayed on the LCD screen. 

4. Click the Continue button. 

5. Step 2: Enter the HUB password on the screen seen below. 
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6. Enter the Hub password. The password is the same password located in your HUB's 

configuration web browser just below the upload channel assigned to the web address for the 

Building Manager Online 3.0. 

a. Important: Set the channel password on your device prior to adding your device to the 

BMO. 

b. If you do not know the hub password, contact the site manager for assistance to access 

the device. 

7. Click the Continue button. 

8. Step 3: Enter the name of this HUB screen on screen below. 

 

9. Enter a unique name for the Hub. 

10. Click the Continue button. 

11. Click Yes to select an existing group. 
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a. Note: The System Network must contain at least one group to select an existing group. 

 

12. Click No to create a new group. 

a. Enter a name for the group. 

 

13. Click the Continue button. 

14. Click the Save button. 

a. The Hub will be displayed in the System Network under an existing group or a new 

group. 



Using Building Manager Online 3.0 

14 | P a g e  

 

15. Click the plus sign next to the group to view the hub. 
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16. Click the plus sign next to the hub to view all meters connected to the hub. 

 

Base Module: Dashboard 

 

1. The base module or home screen consists of the following: 

1. The System Network. 

2. The Alarm Summary. 

3. The main menu (Support, Modules, Wizards, Profile). 
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Base Module: Dashboard > System Network 

 

1. The system network hierarchy consists of the following. 

1. Group: Groups contain hubs. 

2. Hub: Hubs contain devices. 

3. Device: Devices contain data points. 

Note: The system network can be hidden and unhidden by clicking the system network icon. 

(hide) 
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(unhide) 

 

Base Module: Dashboard > Alarms 
An alarm occurs when the BMO receives an error code from the hub. Device alarms are displayed on the 

home screen of the BMO. 

 

The Alarm Summary displays: 

a. The total number of devices: This number represents all devices connected to all of the 

hubs connected to the BMO. 

b. The number of devices in a Normal state: This number represents no alarms. 

c. The number of devices in a Critical state: This number represents a device error. 
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Base Module: Groups 
1. Click the name of any group located in the system network. 

 

The group screen contains a table of hubs with two menu items. 

 

Base Module: Groups > Status 
 The first menu item is Status. This is the default view for a group. 

 

 The group status screen displays all hubs assigned to the selected group. 

 The group status screen displays hub names, serial numbers, firmware versions, Last IP 

addresses and the Last Time each hub uploaded to the Building Manager Online 3.0. 

 Clicking on a hub row allows you to drill into a hub to view all of the meters connected to the 

selected hub. 
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Base Module: Groups > Consumption Report 

 

The second menu item is Consumption Report. 

1. Click the consumption report menu item. 
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The Consumption Report screen is displayed. 

 The consumption report screen displays consumption data for all hubs assigned to the selected 

group. 

 The consumption report screen allows you to view consumption data based on a selected date 

range and time zone. 

 You can change the start date, end date, time zone, and/or cost per unit. 

 

2. Click the update table data button after all changes have been made. 
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3. You can export the consumption data by clicking/pressing the Export Consumption Report 

button. 

 

Base Module: Hubs 
1. Click the name of a group located in the System Network. 

2. Click the name of a hub located below the group. 
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The hub screen is displayed. 

 

The hub screen contains a table of meters with six menu items. 

Base Module: Groups > Hubs > Status 
The first menu item is Status. 

 

 This is the default view for a hub. 

 The hub status screen displays all meters connected to the selected hub. 

 The hub status screen displays serial numbers, firmware versions, and date/time of the last 

uploads to the BMO. 

 Hub status information includes:  

a. Meter device number 

b. Meter status  

c. Meter name & purpose 

d. Meter type  

e. The firmware version of the meter 
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1. Clicking a meter row allows you to navigate to a meter to view all of the data points and energy 

readings for the selected meter. 

 

Base Module: Groups > Hubs > Alarm Notification 
The second menu item is Alarm Notification. 

 

1. Click the Alarm Notification menu item. 
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The alarm notification screen is displayed. 

 

 The alarm notification screen lists all meters connected to the hub. 

 The alarm notification screen allows you to receive email notifications when a hub fails to 

communicate with the Building Manager Online 3.0 for more than 36 hours. 

 The alarm notification screen also allows you to receive email notifications when a meter goes 

into an alarm status. 
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2. To begin receiving alarm notifications for a meter, click the Notify Me checkbox located in the 

row of the meter. 

 

3. Click the Notify Me checkbox for any or all meters from which you would like to receive 

notifications. 

4. When you are finished selecting meters, click the Save button. 

 

Note: Alarm notifications will be sent to the email address registered with the Building Manager 

Online 3.0 account. You can view the email address by clicking/pressing Profile and then 

clicking/pressing My Profile.  

 



Using Building Manager Online 3.0 

26 | P a g e  

The email address will be displayed on the screen. 

 

Base Module: Groups > Hubs > Configuration 
The third menu item is Configuration. Note: This menu option may or may not be visible. HUBS and 

devices added with shared passwords do not have access to the configuration screen. 

Visible 

 

Not Visible 

 

1. Click the Configuration menu item.  

 



Using Building Manager Online 3.0 

27 | P a g e  

The HUB configuration screen is displayed.

 

2. The HUB configuration screen displays the HUB Serial Number, HUB Firmware Version and Last 

Upload Connection. 

3. The HUB configuration screen allows you to overwrite and/or view HUB settings. 

4. Click configuration options to reveal HUB settings. 

 

5. Configuration options. 
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a. Modbus Configuration Options.  

i. HUB Name 

ii. Data Logging period 

iii. Modbus TCP Access 

iv. Modbus RS/485 baud rate 

v. Modbus Timeout 

vi. Modbus Debug 

vii. Search for Modbus Devices 

viii. Search for Sensor Network Devices 
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b. Data Upload Options 

i. Scheduled upload time 

ii. Upload data on alarm status change 

iii. Upload data on low disk alarm 

iv. Upload data on startup 

v. Allow remote Modbus device configuration 

vi. Number of times to retry (on failure) 

 

c. IP Configuration Options 

i. IP Address 

ii. Subnet Mask 

iii. Gateway 

iv. Hostname 

v. DNS1 

vi. DNS2 

vii. DHCP Enabled 

viii. HTTP Proxy Server Address 

ix. HTTP Proxy Server Address Port 

x. Ethernet MTU 

xi. Telnet Enabled 

xii. FTP Enabled 
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d. Modem Options 

i. Modem 

ii. Dialout Enabled 

iii. Dialin Enabled 

 

e. System Info 

i. Base Model 

ii. Full Model 

 

6. Simply navigate out of the HUB configuration screen without clicking the Save button to discard 

changes. 

7. Click the Save button to apply changes. Important: Saved settings will overwrite settings saved in the 

HUB. 
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Base Module: Groups > Hubs > Upload Log 
The fourth menu item is Upload Log. 

 

1. Click the Upload Log menu item. 
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The upload log screen is displayed. 

 

 The upload log screen displays records for all uploads made from the hub to the Building 

Manager Online 3.0. 

 The upload log screen displays the time, IP address and the upload message for each upload 

made from the hub to the Building Manager Online 3.0. 

 Scroll down to the bottom of the screen to change the number of records displayed per page 

and/or page through all log records. 

 

Base Module: Groups > Hubs > Share Hub 
The fifth menu item is Share HUB. 
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1. Click the Share HUB menu item. 

 

 The share a hub screen is displayed. 

 The share a hub screen allows you to select a hub and then temporarily assign a password to the 

hub. You can then share the serial number and temporary password with another Building 

Manager Online 3.0 user. 

 This allows you to share the hub and meter data with another user without granting full access 

to your hub. 

 The user will not be able to edit the configuration settings of the shared hub. 

 The BMO will only store one shared password per hub. 

 When a shared password is changed, the shared user no longer has access to the shared hub. 

 

2. Select the Serial Number for the hub you would like to share. 

3. Click the Continue button. 
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4. Enter the HUB password. This is the same password set in the upload page of the hub. 

a. Important: Set the channel password on your device prior to adding your device to the 

Building Manager Online 3.0. 

b. If you do not know the hub password, contact the site manager for assistance to access 

the device. 

5. Click the Continue button. 

 

6. Enter the share password for the hub. 

a. Note that this is a temporary password assigned to a hub that allows you to share the 

hub with another Building Manager Online 3.0 user. 

b. If a share password is assigned to this hub at a later date, the data connection for the 

original share will be discontinued. 

7. Click the Save button. 
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Base Module: Groups > Hubs > Remove Hub 
The sixth menu item is Remove HUB. 

 

1. Click the Remove HUB menu item. 
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2. The remove hub screen is displayed. This option allows you to remove a hub from a group. 

3. Step 1. Select the serial number for the hub you would like to remove. 

 

4. Click the Continue button. 

5. Acknowledge and Confirm Deletion of Hub. 

6. Click the “I have read and understand…” checkbox. 

7. Click the Delete button. 
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Base Module: Devices 
1. Click the name of a group located in the system network. 

2. Click the name of a hub located below the group. 

3. Click the name of the device located below the hub. 

 

The device screen contains a table of data points with seven menu items. 
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Base Module: Groups > Hubs > Devices > Status 
The first menu item is Status. This is the default view for a device. 

 

1. Click Status to display the Device Status Screen. 

 

 The device status screen displays all data points within a device. 

 The device status screen displays the device name and number, the device type, the status of 

the device, the date/time of the last upload and the date/time of the last reading. 

 The device status screen table displays the name of the data point, the current reading, the low 

and high alarms (if set). 

 

2. Scroll down to the bottom of the screen to change the number of records displayed per page 

and/or page through all data points. 
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Base Module: Groups > Hubs > Devices > Graphs 
The second menu item is Graph. 

 

1. Click the Graph menu item. 
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The device graph screen is displayed. 

 

 The graph screen displays the device name and number, the device type, and the date range of 

the available data. 

 The graph screen allows you to set a date range, select a time zone, and select up to four data 

points. 

 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Click the time zone. 

8. Click the dropdown for Data Point 1 and select a data point. 

9. Data points are color coded. Colors will display on graph. 

10. Select up to four data points. 

11. Click the Update Graph button. 
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The graph is rendered. 

 

12. Hover over the data points to view detailed information for each input. 
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13. Hover over the graph and click and then drag and release to zoom in. 

 

14. Press the reset button to reset the zoom on the graph to the original view. 

 

15. Click the Update Graph button to render the graph whenever the date range, time zone, or data 

points are changed. 

 

Base Module: Groups > Hubs > Devices > Configuration 
The third menu item is Configuration. Note: This menu item may or may not be visible. HUBS and 

devices added with shared passwords do not have access to the configuration screen 

Visible 
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Not Visible 

 

1. Click the Configuration menu item.  

 

The device configuration screen is displayed. 

 

2. The device configuration screen displays the device number and device type. 

3. The device configuration screen allows you to overwrite data point names, units of measure, low 

alarms, high alarms and enable or disable the Console. 

a. The console box, if checked will allow the alarm condition to be displayed on the HUB 

display screen until cleared. 

4. Highlight and enter the information you would like to overwrite. 
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5. Simply navigate out of the device configuration screen without clicking the Save button to discard 

changes. 

6. Click the Save button to apply changes. 

7. Click the Save button to save updates. Important: Saved settings will overwrite settings saved in the 

device. 

 

Base Module: Groups > Hubs > Devices > View Data 
The fourth menu item is View Data. 

 

1. Click the View Data menu item. 
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The view data screen is displayed. 

 

 The view data screen displays the device name and number, the device type, and the date range 

of the available data. 

 The view data screen displays a table containing all data and data points for the selected date 

range. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Select the time zone. 

8. Click the Update Table Data button. 



Using Building Manager Online 3.0 

46 | P a g e  

 

The data table will refresh based on the selections. 

9. Scroll down to the bottom of the screen to page through data. 

10. Click the Update Table Data button to populate the table with data whenever the date range or 

time zone is changed. 

 

Base Module: Groups > Hubs > Devices > Export Data 
The fifth menu item is export data. 

 

1. Click the Export Data menu item. 
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The export data screen is displayed. 

 

 The export data screen displays the device name and number, the device type, the date/time 

range of the available data. 

 The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Select a Delimiter to determine whether the data should export as Comma Delimited or Tab 

Delimited. 
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9. Click the Add column headers checkbox to deselect or select whether column headers should be 

added to the exported text file. 

 

10. Click the Export Data button. 

 

The text file will download. 

11. If the text file does not appear to download, make sure your web browser popup blocker is not 

blocking the file. 

Base Module: Groups > Hubs > Devices > Data Format 
The sixth menu item is data format. 

 

1. Click the Data Format menu item. 
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The data format screen is displayed. 

 

The purpose of this screen is to provide you with the information necessary to recreate the database 

tables in another database. Use this option if you would like to export the device data and then import 

the data into your database. 

 The data format screen displays the device name and number and the device type. 

 The data format screen displays the field and data type for all data points. 

 The data format screen displays the SQL statement for recreating the tables. 

Base Module: Groups > Hubs > Devices > Remove Device 
The seventh menu item is Remove Device. 

 

1. Click the Remove Device button. 
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The remove device screen is displayed. 

 

 Note: Making changes via the remove device screen does not disconnect the physical device 

from the physical hub. 

 The remove device screen allows you to purge all data from the Building Manager Online 3.0 for 

a selected device. This will not physically remove the device from the hub. If the device has not 

been physically disconnected from the hub, the next time the hub communicates/uploads data 

to the Building Manager Online 3.0, the removed device will be refreshed with new/current 

data. 

 

2. Click the “I have read and understand…” checkbox. 

3. Click the Remove Device button. 
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Code Compliance Module: Overview 
This software module will allow you to meet the established and growing requirements of local 

municipal codes such as the Seattle Energy Code and CA Title 24 requirements along with those of 

developing versions of ASHRAE 90.1. 

 

 The Code Compliance module is an expansion module that must be purchased. 

 If you are interested in purchasing the Code Compliance module, see Modules Menu > Purchase 

Modules. 
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1. If the module has been purchased, click Modules > click Code Compliance. 

 

The Code Compliance module is displayed. The Code Compliance module contains four menu items: 

 Building Setup 

 Code Compliance Setup 

 Virtual Meters 

 Code Compliance Reports 

 

Code Compliance Module: Building Setup 
1. Click the Building Setup button. 
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The Buildings list screen is displayed. 

 

 The Buildings list screen displays a map pinpointing the location for each building added to the 

Building Manager Online 3.0. 

 The Building list screen contains a table listing all buildings added to the Building Manager 

Online 3.0. 

 

Code Compliance Module: Building Setup > Add New Building 
1. Click the Add New Building button. 
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The Building Setup screen is displayed. 

 

2. Enter building attributes.  

a. Name of the Building 

b. Address Line 1 

c. Address Line 2 (optional) 

d. City 

e. State 

f. Zip Code 

g. Country 

h. Fields such as Square footage may be displayed if other modules are purchased. 

3. Enter each utility cost. 

a. Electric 

i. Kwh 

ii. kW – Average 

iii. kW – Peak 

b. Gas Cost 

c. Steam Cost 
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d. BTU Cost 

 The utility cost information will be used in calculations when generating the code compliance 

reports. 

 Note: The utility cost information must be entered or the Code Compliance reports will not 

provide the desired results. 

 

4. Click the Cancel button to discard changes OR 

5. Click the Save button to add the building to the Buildings list screen. 

Code Compliance Module: Building Setup > Edit Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

The Building Edit screen is displayed. 

 

2. Click the field to be modified. 

3. Enter changes. 

4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 
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Code Compliance Module: Building Setup > Remove Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

2. The Building Edit screen is displayed. 

 

3. Click the Active checkbox to remove the building from the Buildings list screen. 

 
4. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

building will no longer appear in the Buildings list screen and you will not be able to access the 

building from other areas of the Building Manager Online 3.0. 

5. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes. 

6. Click the Save button to remove the building. 
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Code Compliance Module: Building Setup > Adding a Removed Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

2. The Building Edit screen is displayed. 

 

3. Click the Active checkbox to add the building back to the Buildings list screen. 

 
4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes. 

5. Click the Save button to add the building. 
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Code Compliance Module: Code Compliance Setup 
1. Click the Code Compliance Setup button. 

 

The Code Compliance Module Setup screen is displayed. 

 

2. Select Group.  

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

3. Select Hub.  

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. 

c. Note: Available hub selections are based on the prior group selection. 

4. Select Building. 

a. Available buildings are active buildings located in the Buildings list screen. 

b. Selecting a building creates a relationship between the building and the hub to be used 

in Code Compliance reporting. 

5. Click the Cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes. 

6. Click the Save button to save changes. 
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Code Compliance Module: Virtual Meters 
Virtual meters allow you to add or subtract real data points to produce virtual data points. You can only 

create virtual meters from real data points of the same type such as kW, Degree F, etc. Only hubs with a 

data upload interval of 15 minutes can be used to create Virtual meters.  

1. Click the Virtual Meters button. 

 

The Virtual Meters list screen is displayed. 

 

 The Virtual Meters list screen contains a table listing all virtual meters added to the Building 

Manager Online 3.0. 

 The Virtual Meters list screen contains a table and two main navigational menu items. 

 The table lists all Virtual Meters added to the Building Manager Online 3.0. 

 The two navigational menu items are Add New Virtual Meter and Home. 

 The Virtual Meters list screen allows you to filter your virtual meters by Building. 

 

 

2. Click the Home button to return to the home screen of the Building Manager Online 3.0. 

Code Compliance Module: Virtual Meters > Add 
1. Click the Add New Virtual Meter button. 
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The Create Virtual Meter screen is displayed. 

 

2. Enter Virtual Meter Label.  

a. This will be the name of the Virtual Meter. 

3. Select Building. 

a. The purpose of this selection is help you keep track of your virtual meters by allowing 

you to see which building is associated with each virtual meter. 

4. Select Group.  

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

5. Select Hub.  

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. 

c. Note: Available hub selections are based on the prior group selection. 

6. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  

c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

7. Select Data Point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. 
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c. Note: Available data point selections are based on the prior hub selection. 

 

 

The selected data point will display in the Virtual Calculations box. 

 

The selected data point will also display below the Virtual Data Point Definition heading. 

 

Note: A virtual meter formula/equation is known as a virtual meter definition. 

8. Click the appropriate mathematical operator. 

a. Plus sign (+) 

i. The plus sign (+) will add the selected data point value to the next data point 

value. 
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b. Subtraction sign (-) 

i. The subtraction sign (-) will subtract the next data point value from the selected 

data point value. 

 

c. Clear button (Ø). 

i. Click the clear button to remove elements from a Virtual Calculations definition. 

ii. Note: The clear button will only remove a data point or operator at the end of a 

definition/equation. 

iii. Click the last data point or operator in the definition/equation. 

iv. Click the clear button. 
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9. Click the data point dropdown and click the next data point. Note: The data point dropdown 

field is used for selecting the initial data point and each additional data point. 

 

10. Repeat adding data points and mathematical operators until the definition is complete. 

a. Process for Building Virtual Meters: 

i. Step 1 Select Data Point 

ii. Step 2 Select Mathematical Operator 

iii. Step 3 Select Data Point 
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11. Note: Virtual Meters must be of the same type (e.g., kW, Degree F, etc.). 

12. Like data points can be added and subtracted from different hubs, groups, and other virtual 

meters. 

a. Process for Building Virtual Meters using multiple groups or hubs: 

i. Step 1 Select Data Point 

ii. Step 2 Select Mathematical Operator 

iii. Step 3 Select Group 

iv. Step 4 Select Hub 

v. Step 5 Select Data Point 

13. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

14. Click the Reset Selections button to clear the screen and start over OR 

15. Click the Save button to save the virtual meter. The Virtual Meters list screen is displayed and 

the newly created virtual meter is listed. 

 

Code Compliance Module: Virtual Meters > Edit 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 
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The virtual meter edit screen is displayed. 

 

2. From this screen, you can: 

a. Change the label (name) of the meter. 

b. Select a Building for the Virtual Meter. 

c. Select additional Groups. 

d. Select additional hubs (must first select the group). 

e. Select additional data points (must first select the hub). 

f. Add and remove data points and operators to and from the Virtual Data Point 

Definition. 

3. Make the necessary edits on the page. 

4. Click the Back to Virtual Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

5. Click the Reset Selections button to clear the screen and start over OR 

6. Click the Save button to save changes. 

 

 

 

Code Compliance Module: Virtual Meters > Remove 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 
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The virtual meter edit screen is displayed. 

 

2. Click the Active checkbox to remove the virtual meter from the virtual meter list screen. 

 

3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

virtual meter will no longer appear in the virtual meter list screen and you will not be able to 

access the virtual meter from other areas of the Building Manager Online 3.0. 

4. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

5. Click the Save button to save the change. 
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Code Compliance Module: Virtual Meters > Adding a Removed Virtual Meter 
1. To add a removed virtual meter, click the Edit link in the row of the virtual meter located in the 

Actions column on the virtual meter list screen or simply click the name of the virtual meter. 

 

The virtual meter edit screen is displayed. 

 

2. Click the Active checkbox to add the virtual meter back to the virtual meters list screen. 
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3. Click the Back to Virtual Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

4. Click the Save button to activate the virtual meter. 

Code Compliance Module: Virtual Meters > View Data 
1. Click the View Data link in the Actions column of the virtual meter list screen. 

 

The view data screen is displayed. 

 

 The view data screen displays the name of the virtual meter, the definition (equation) used to 

calculate the virtual data points. 

 The view data screen displays three menu items: 
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 The first menu item is View Data. The View Data link is also located on the virtual meters 

list screen under the Actions column. This is the default view for a virtual meter. 

 The view data screen displays a table containing all data and virtual data points for the selected 

date range. 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Table Data button. 

 

The data table will refresh based on the selections. 

9. Scroll down to the bottom of the screen to page through data. 

 

10. Click the Update Table Data button to populate the table whenever the date range or time zone 

is changed. 

 

Code Compliance Module: Virtual Meters > Graph 
1. Click the Graph link in the virtual meters list screen under the Actions column. 

 

Graph is the second menu item. 
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2. The graph screen displays the name of the virtual meter and the definition (equation) used to 

calculate the virtual data points. 

 

 A graph is rendered based on the default date range. 

 The graph screen allows you to set a date range and select a time zone. 

 

3. Select a range of data by clicking the date range picker. 

4. Select a start date. 

5. Select an end date. 

6. Click the Apply button. 

7. Select the time zone by clicking/pressing the time zone dropdown. 

8. Click the time zone. 

9. Click the Update Graph button. 

 

The graph is rendered. 

10. Hover over the data points to view detailed information for each input. 
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11. Hover over the graph and click and then drag and release to zoom in. 

 

12. Press the Reset zoom button to reset the zoom on the graph. 

 

13. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 
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Code Compliance Module: Virtual Meters > Export 
1. Click the Export Data menu item located in the virtual meters list screen under the Actions 

column. 

 

Export Data is the third menu item. 

 

The Export Data screen is displayed. 

 

 The export data screen displays the name of the virtual meter and the definition (equation) used 

to produce data. 

 The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 
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6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Excel (xls) button to export the data in an xls file format. 

 

9. Click the Excel (xlsx) button to export the data in an xlsx file format. 

10. Click the CSV button to export the data in a comma separated values file format. The file will 

download. Note: If the file does not appear to download, make sure the popup blocker in your 

web browser is not blocking the file. 

Code Compliance Module: Code Compliance Reports 
1. Click the Code Compliance Reports button. 
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The Code Compliance Reports screen is displayed. 

 

 The Code Compliance Reports screen displays a table containing a list of all available reports. 

 The Code Compliance Reports screen contains links under the Actions column to View Data, 

Graph, Export data, and the Configuration screen for each report. 

 The Code Compliance Reports screen allows you to filter reports by end use, whole building, or 

all reports. The default selection displays all reports. 

 

Code Compliance Module: Code Compliance Reports > Configuration 
1. Click the Configuration link in the Actions column for the report you would like to configure. 
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a. If the report has not been configured, clicking the name of the report will also return the 

report configuration screen. 

The report configuration screen is displayed. 

 

Note: Each report must be configured prior to use. 

a. The Code Compliance Module Setup screen must be configured prior to configuring 

reports through the reports configuration screen (Code Compliance > Code Compliance 

Module Setup).  

 

 
b. The selected building must have all utility costs defined in the building setup screen 

prior to configuring reports (Code Compliance > Building Setup > Edit). 
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2. Select the Device for Consumption Data Point. 

3. Select the Consumption Data Point. 

4. Select the Device for Demand Data Point. 

5. Select the Demand Data Point. 

6. Click the Go Back button to discard changes and return to the Code Compliance Reports screen 

OR 

7. Click the Save button to complete the configuration process. 

8. Repeat the configuration process for all Code Compliance Reports. 

Code Compliance Module: Code Compliance Reports > View Data 
1. Click the View Data link in the Actions column for the report you would like to configure. 

 

The view data screen is displayed. 
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 The view data screen is the default screen when a configured report is clicked. Note: If the 

report has not been configured, clicking the view data link will return the report configuration 

screen. 

 The view data screen displays the name of the report, the date/time range of the consumption 

data and the date/time range of the demand data. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Report button. 

 

The table will display the value and cost for the consumption, demand (average), and demand (peak) for 

the selected date range. 

Code Compliance Module: Code Compliance Reports > Graph 
1. Located in the row of the report name, click the Graph link in the Actions column. 

 

a. If the report has not been configured, clicking/pressing the Graph link will return the 

report configuration screen. 
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The graph screen displays the name of the report and the date/time range for the available data. 

 

 A default date range is selected and a default graph is rendered. 

 The graph screen allows you to set a date range, select a time zone, and select data rollup. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Select a data rollup period by clicking/pressing the data rollup dropdown. 

9. Click the period. 

10. Click the Update Graph button. 
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The graph is rendered. 

11. Hover over the data points to view detailed information for each input. 

 

12. Hover over the graph and click and then drag and release to zoom in. 
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13. Press the Reset zoom button to reset the zoom on the graph. 

 

14. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 

 

Code Compliance Module: Code Compliance Reports > Export 
1. Located in the row of the report name, click the Export link in the Actions column. 

a. If the report has not been configured, clicking the Export link will return the report 

configuration screen. 

 

The export data screen displays the name of the report and the date/time range of the available report 

data. 
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The export data screen allows you to select a date range and time zone and then export the data to a 

text file. 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Report button. 

 

9. The data table is refreshed and displays the value and cost of consumption, demand (average), 

and demand (peak) data. 

10. Click the Excel (xls) button to export the data in an xls file format. 

 

11. Click the Excel (xlsx) button to export the data in an xlsx file format OR 

12. Click the CSV button to export the data in a comma separated values file format OR 

13. Click the PDF button to export the data in a PDF file format. 

The file will download. Note: If the file does not appear to download, make sure the popup blocker 

in your web browser is not blocking the file. 
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Executive Reporting Module: Overview 
The Executive Reporting module allows executive stakeholders to readily access and understand energy 

usage and cost data specific to their facilities and portfolios. 

 

 The Executive Reporting module is an expansion module that must be purchased. 

 If you are interested in purchasing the Executive Reporting module, see Modules Menu > 

Purchase Modules. 

 

1. If the module has been purchased, click Modules > click Executive Reporting. 
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The Executive Reporting module is displayed. The Executive Reporting module contains seven menu 

items: 

a. Building Setup 

b. Building Portfolio Setup 

c. Virtual Meters 

d. Executive Reporting Dashboard 

e. Executive Reporting Alerts 

f. Executive Reporting Base Case 

g. Executive Reporting Building Goals 

 

Executive Reporting Module: Building Setup 
1. Click the Building Setup button. 
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2. The Buildings list screen is displayed. 
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The Buildings list screen displays a map pinpointing the location for each building added to the Building 

Manager Online 3.0 and contains a table listing all buildings added to the Building Manager Online 3.0. 

Executive Reporting: Building Setup > Add New Building 
1. Click the Add New Building button. 

 

The Building Setup screen is displayed. 

 

2. Enter building attributes.  

a. Name of the Building 
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b. Address Line 1 

c. Address Line 2 (optional) 

d. City 

e. State 

f. Zip Code 

g. Country 

h. Square Footage 

3. Enter each utility cost. 

a. Electric 

i. Kwh 

ii. kW – Average 

iii. kW – Peak 

b. Gas Cost 

c. Steam Cost 

d. BTU Cost 

4. Click the Cancel button to discard changes OR 

5. Click the Save button to add the building to the buildings list screen. 

Executive Reporting: Building Setup > Edit Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

The Edit building screen is displayed. 

 

2. Click the field to be modified. 
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3. Enter changes. 

4. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Executive Reporting: Building Setup > Dashboard 
1. Click the Dashboard link in the row of the building located in the Actions column on the 

Buildings list screen. 

 

The Building Dashboard screen displays the building name, the current weather condition for the 

location of the building, a map displaying the location of the building, and a list of reports. 

 

The Building Dashboard will display goal gauges when building goals are added. 
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The building dashboard screen contains three menu options: 

 

 Edit Building. This is a shortcut to the Executive Reporting > Building Setup > Edit screen. 

 Base Case. This is a shortcut to the Executive Reporting > Base Cases screen. 

 Building Goals. This is a shortcut to the Executive Reporting > Building Goals List screen. 

The list contains custom and standard reports. 

 

Executive Reporting: Building Setup > Dashboard > Reports > Add Report 
1. Click the Add Report button. 

 

The Add Portfolio Report screen is displayed. 

 

2. Enter the Report Name. 

3. Click to the Portfolio checkbox to display the report under Building Portfolio Setup. 

4. Select the category. 
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5. Click the Setup checkbox to display the Configuration link in the Actions column. 

6. Click the Export checkbox to display the Export link in the Actions column. 

7. Click the Chart checkbox to display the Graph link in the Actions column. 

8. Click the Back to Dashboard button without clicking the Save button to discard changes OR 

9. Click the Save button.  

10. The Building Dashboard is displayed. 

11. The saved report is displayed in the list of reports. 

 

Executive Reporting: Building Setup > Dashboard > View Data 
1. Click the View Data link in the row of the building located in the Actions column on the Building 

Dashboard screen. 

 

The view data screen is the default screen when a configured report is clicked. 

 

Note: If the report has not been configured, clicking/pressing the view data link will return the report 

configuration screen. 
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The view data screen displays the name of the report and the date/time range of the available report 

data. 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Report button. 

 

The table will display address of the building, the value and the cost of consumption for the selected 

date range. 

Executive Reporting: Building Setup > Dashboard > Graph 
1. Located in the row of the report name, click the Graph link in the Actions column. 

 

a. If the report has not been configured, clicking the Graph link will return the report 

configuration screen. 

The graph screen is displayed. The graph screen displays the name of the report and the date/time 

range of the available report data. 
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 A default date range is selected and a default graph is rendered. 

 The graph screen allows you to set a date range, select a time zone, select data rollup, and 

select a graph type. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Select a data rollup period by clicking the data rollup dropdown. 

9. Click the period. 

10. Select a graph type by clicking/pressing the graph type dropdown. 

11. Click the graph type. 

12. Click the Update Graph button. 

 

The graph is rendered. Note: Graph types such as a line graph will allow you to zoom. Some of the graph 

types will not allow you to zoom. 

13. Hover over the data points to view detailed information for each input. 
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14. Hover over the graph and click and then drag and release to zoom in. 

 

15. Press the Reset zoom button to reset the zoom on the graph. 
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16. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 

 

Executive Reporting: Building Setup > Dashboard > Export 
1. Located in the row of the report name, click the Export link in the Actions column. 

 

a. If the report has not been configured, clicking the Export link will return the report 

configuration screen. 

The export data screen is displayed. 

 

 The export data screen displays the name of the report and the date/time range of the available 

report data.  

 The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 
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6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Report button. 

 

9. The data table is refreshed and displays the building name, building location, and the value and 

cost of the consumption data. 

10. Click the Excel (xls) button to export the data in an xls file format. 

 

11. Click the Excel (xlsx) button to export the data in an xlsx file format OR 

12. Click the CSV button to export the data in a comma separated values file format OR 

13. Click the PDF button to export the data in a PDF file format. 

The file will download. Note: If the file does not appear to download, make sure the popup blocker in 

your web browser is not blocking the file. 

Executive Reporting: Building Setup > Dashboard > Configuration 
1. Located in the row of the report name, click the Configuration link in the Actions column. For 

reports without a Configuration link, click the name of the report (ADHOC/Comparison Report, 

Base Case Comparison Report. Etc.) to configure the report. 

 

2. The report configuration screen is displayed. 
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Configuration requirements will differ by report: 

a. Custom (Add Report)  

i. Select Utility. 

ii. Select Group. 

iii. Select Hub. 

iv. Select Device. 

v. Select Data Point. 

vi. Click Go Back to Building without clicking the Save button to discard changes OR 

vii. Click the Save button to save changes. 

b. ADHOC/Comparison Report *Report does not save. Must be configured when used. 

i. Select Group 1. 

ii. Select Hub 1. 

iii. Select Device 1. 

iv. Select Data Point 1. 

v. Select Group 2. 

vi. Select Hub 2. 

vii. Select Device 2. 

viii. Select Data Point 2. 

ix. Select Date Range. 

x. Select Time Zone. 

xi. Click Update Report. The report table displays the time and values for each data 

point. 

c. Base Case Comparison Report *Report does not save. Must be configured when used. 

i. Select a Base Case. 
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ii. Select a Group. 

iii. Select a Start Date. 

iv. Select a Time Zone. 

v. Click the Update Data button. The report table displays the name of the base 

case, the value of the base case, the start and end date of the report, and the 

number of days used in the base case for the report. 

d. Carbon Footprint Report 

i. Select the Fuel Type. 

ii. Select Group. 

iii. Select Hub. 

iv. Select Device. 

v. Select Data Point. 

vi. Click Go Back to Building without clicking the save button to discard changes OR 

vii. Click the Save button to save changes. 

Executive Reporting Module: Building Portfolio Setup 
1. Click the Building Portfolio Setup. 

 

The Building Portfolios list screen is displayed. The Building Portfolios list screen displays a table 

containing a list of all saved building portfolios. 
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Executive Reporting: Building Portfolio Setup > Add Building Portfolio 
1. Click the Add Building Portfolio button. 

 

The Building Portfolio setup screen is displayed. 

 

2. Enter a name for the portfolio. 

3. Enter a description for the portfolio. 

4. Click the Cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes OR 

5. Click the Save button to save the portfolio. The building portfolio name is displayed in the 

Building Portfolios list. 

Executive Reporting: Building Portfolio Setup > Edit Building Portfolio 
1. Click the Edit link in the Actions column, which is located in the row of the report name. 
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The Building Portfolio screen is displayed. 

 

2. Click the field to be modified. 

3. Enter changes. 

4. Located in the row of the building name, click the add checkbox in the Add column to add 

buildings to the building portfolio. 

 

5. Click the Add checkbox to add and remove buildings from the building portfolio. 

6. Click the cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes OR 

7. Click the Save button to save changes. 

Executive Reporting: Building Portfolio Setup > Remove Building Portfolio 
1. Located in the row of the building portfolio name, click the Edit link in the Actions column. 
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The Building Portfolio screen is displayed. 

 

2. Click the Active checkbox to remove the building portfolio from the Building Portfolios list 

screen. 

 

Note: When the checkbox is empty (doesn’t contain a check) and the edits have been saved, the 

portfolio will no longer appear in the Building Portfolios list screen and you will not be able to access the 

building portfolio from other areas of the Building Manager Online 3.0. 

3. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

4. Click the Save button to save changes. 
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Executive Reporting: Building Portfolio Setup > Adding a Removed Building 

Portfolio 
1. To add a removed Building Portfolio, click the Edit link in the row of the building portfolio name 

located in the Actions column on the Building Portfolios list screen or simply click the name of 

the building portfolio. 

 

The Building Portfolio screen is displayed. 

 

2. Click the Active checkbox to add the building portfolio back to the Building Portfolios list screen. 

 

3. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

4. Click the Save button to save changes. 
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Executive Reporting: Building Portfolio Setup > Reports 
1. Located in the row of the report name, click the Reports link in the Actions column. 

 

The Portfolio Reports screen is displayed. 

 

 The Portfolio Reports screen displays a table containing a list of all portfolio reports. 

 The Actions column links will differ based on report. 

Executive Reporting: Building Portfolio Setup > Reports > View Data 
1. Located in the row of the report name, click the view data link in the Actions column. 

 

a. If the report has not been configured, clicking the view data link will return the report 

configuration screen. 

b. The configuration screen for Building Profile reports will differ. For some of the reports, 

the report must be configured each time the report is run. 
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The view data screen is the default screen when a configured report is clicked. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. For the ADHOC/Comparison Report 

a. Select Group 1 

b. Select Hub 1 

c. Select Device 1 

d. Select Data Point 1 

e. Select Group 2 

f. Select Hub 2 

g. Select Device 2 

h. Select Data Point 2 

9. For the Base Case Comparison Report 

a. Select a Base Case 

10. Click the Update Report button.  

 

11. The data table will populate. Table data will vary based on report. 
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Executive Reporting: Building Portfolio Setup > Reports > Graph 
1. Located in the row of the report name, click the Graph link in the Actions column. 

 

a. If the report has not been configured, clicking/pressing the Graph link will return the 

report configuration screen. 

A default date range is selected and a default graph is rendered. 

 

The graph screen allows you to set a date range, select a time zone, select data rollup, and select a 

graph type. 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 
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7. Select the time zone. 

8. Select a data rollup period by clicking/pressing the data rollup dropdown. 

9. Select the period. 

10. Select a graph type by clicking/pressing the graph type dropdown. 

11. Click the graph type. 

12. Click the Update Graph button. 

 

The graph is rendered. Note: Zoom functionality varies by graph type. Graph types such as line graphs 

will allow you to zoom in on the graph. Graph types such as bar graphs will not allow you zoom in on the 

graph.  

a. Hover over the data points to view detailed information for each input. 

 

b. Hover over the graph and click and then drag and release to zoom in. Only applicable on 

certain graph types. 

c. Press the Reset zoom button to reset the zoom on the graph. Only applicable on certain 

graph types. 

13. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 

 

Executive Reporting: Building Portfolio Setup > Reports > Export 
1. Located in the row of the report name, click the export link in the Actions column. 

 

a. If the report has not been configured, clicking/pressing the export link will return the 

report configuration screen. 
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The export data screen is displayed. 

 

 The export data screen displays the name of the report. 

 The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Click the time zone. 

8. Click the Update Report button. 

 

The view data table is refreshed and displays the name of the building, the building location, and the 

value and cost of consumption data. 

9. Click the Excel (xls) button to export the data in an xls file format OR 
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10. Click the Excel (xlsx) button to export the data in an xlsx file format OR 

11. Click the CSV button to export the data in a comma separated values file format OR 

12. Click the PDF button to export the data in a PDF file format. 

The file will download. Note: If the file does not appear to download, make sure the popup blocker 

in your web browser is not blocking the file. 
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Executive Reporting Module: Virtual Meters 
Virtual meters allow you to add or subtract real data points to produce virtual data points. You can only 

create virtual meters from real data points of the same type such as kW, Degree F, etc. Only hubs with a 

data upload interval of 15 minutes can be used to create Virtual meters.  

1. Click the Virtual Meters button. 

 

The Virtual Meters list screen is displayed. 

 

 The Virtual Meters list screen contains a table listing all virtual meters added to the Building 

Manager Online 3.0. 

 The Virtual Meters list screen contains a table and two main navigational menu items. 

 The table lists all Virtual Meters added to the Building Manager Online 3.0. 

 The two navigational menu items are Add New Virtual Meter and Home. 

 The Virtual Meters list screen allows you to filter your virtual meters by Building. 
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2. Click the Home button to return to the home screen of the Building Manager Online 3.0. 

 

Executive Reporting: Virtual Meters > Add 
1. Click Add New Virtual Meter button. 

 

The Create Virtual Meter screen is displayed. 

 

2. Enter Virtual Meter Label.  

a. This will be the name of the Virtual Meter. 

3. Select Building. 

a. The purpose of this selection is help you keep track of your virtual meters by allowing 

you to see which building is associated with each virtual meter. 

4. Select a Group.  

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

5. Select a Hub.  

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. Note: Available hub selections are based on the prior group 

selection. 

6. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  
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c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

7. Select a Data Point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. 

c. Note: Available data point selections are based on the prior hub selection. 

The selected data point will display in the Virtual Calculations box. 

 

The selected data point will also display below the Virtual Data Point Definition heading. 

 

Note: A virtual meter formula/equation is also known as a virtual meter definition. 

8. Click the appropriate mathematical operator. 

a. Plus sign (+) 

i. The plus sign (+) will add the selected data point value to the next data point 

value. 
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b. Subtraction sign (-) 

i. The subtraction sign (-) will subtract the next data point value from the selected 

data point value. 

 

9. Clear button (Ø). 

a. Click the clear button to remove elements of a Virtual Calculations definition. Note: The 

clear button will only remove a data point or value at the end of a definition/equation. 

b. Click the last data point or operator in the definition/equation. 

c. Click the Clear button. 
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10. Click the data point dropdown and click the next data point. Note: The data point dropdown 

field is used for selecting the initial data point and each additional data point. 

 

11. Repeat adding data points and mathematical operators until the definition is complete. Note: 

Virtual Meters must be of the same type (e.g., kW, Degree F, etc.). 

a. Process for Building Virtual Meters: 

i. Step 1 Select Data Point. 

ii. Step 2 Select Mathematical Operator. 

iii. Step 3 Select Data Point. 
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Also note: Like data points can be added and subtracted from different groups and hubs. 

b. Process for Building Virtual Meters using multiple groups or hubs: 

i. Step 1 Select Data Point 

ii. Step 2 Select Mathematical Operator 

iii. Step 3 Select Group 

iv. Step 4 Select Hub 

v. Step 5 Select Data Point 

 

12. Click the Back to Virtual Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

13. Click the Reset Selections button to clear the screen and start over OR 

14. Click the Save button to save the virtual meter. The virtual meters list screen is displayed and 

the newly created virtual meter is listed. 

 

Executive Reporting: Virtual Meters > Edit 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 

 

The virtual meter edit screen is displayed. 
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2. You can: 

a. Change the label (name) of the meter. 

b. Select a Building for the Virtual Meter. 

c. Select additional Groups. 

d. Select additional hubs (must first select the group). 

e. Select additional data points (must first select the hub). 

f. Add and remove data points and operators to and from the Virtual Data Point 

Definition. 

3. Make the necessary edits. 

4. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR  

5. Click the Reset Selections button to clear the screen and start over OR 

6. Click the Save button to save changes. 

Executive Reporting: Virtual Meters > Remove 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 

 

The virtual edit screen is displayed. 
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2. Click the Active checkbox to remove the virtual meter from the virtual meter list screen. 

 
3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

virtual meter will no longer appear in the virtual meter list screen and you will not be able to 

access the virtual meter from other areas of the Building Manager Online 3.0. 

4. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

5. Click the Save button to save the change. 

Executive Reporting: Virtual Meters > Adding a Removed Virtual Meter  
1. To add a removed virtual meter, click the Edit link in the row of the virtual meter located in the 

Actions column on the virtual meter list screen or simply click the name of the virtual meter. 
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The virtual edit screen is displayed. 

 

2. Click the Active checkbox to add the virtual meter back to the virtual meters list screen. 

 
3. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

4. Click the Save button activate the virtual meter. 
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Executive Reporting: Virtual Meters > View Data 
1. Click the View Data link in the Actions column of the virtual meter list screen. 

 

The view data screen is displayed. 

 

 The view data screen displays the name of the virtual meter, the definition (equation) used to 

calculate the virtual data points. 

 The view data screen displays three menu items. 

 The first menu item is View Data. The View Data link is also located on the virtual meters list 

screen under the Actions column. 

 

 This is the default view for a virtual meter. 

 The view data screen displays a table containing all data and virtual data points for the selected 

date range. 

 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Select the time zone. 

8. Click the Update Table Data button. 
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The data table will refresh based on the selections. 

9. Scroll down to the bottom of the screen to page through data. 

 

10. Click the Update Table Data button to populate the table with data whenever the date range or 

time zone is changed. 

 

Executive Reporting: Virtual Meters > Graph 
1. Click the Graph link in the virtual meters list screen under the Actions column. 

 

Graph is the second menu item. 

 

The graph screen displays the name of the virtual meter and the definition (equation) used to calculate 

the virtual data points. 
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 A default date range is selected and a default graph is rendered. 

 The graph screen allows you to set a date range and select a time zone. 

 

2. Select a range of data by clicking the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking the time zone dropdown. 

7. Select the time zone. 

8. Click the Update Graph button. 

 

The graph is rendered onscreen. Hover over the data points to view detailed information for each input. 
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9. Hover over the graph and click and then drag and release to zoom in. 

 

10. Press the Reset zoom button to reset the zoom on the graph. 
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11. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 

 

Executive Reporting: Virtual Meters > Export 
1. Click the Export link located in the virtual meters list screen under the Actions column. 

 

Export Data is the third menu item. 

 

The Export Data screen is displayed. 

 

2. The export data screen displays the name of the virtual meter and the definition (equation) used 

to produce data. 

3. The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

4. Select a range of data by clicking the date range picker. 

5. Select a start date. 

6. Select an end date. 
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7. Click the Apply button. 

8. Select the time zone by clicking/pressing the time zone dropdown. 

9. Select the time zone. 

10. Click the Excel (xls) button to export the data in an xls file format OR 

 

11. Click the Excel (xlsx) button to export the data in an xlsx file format OR 

12. Click the CSV button to export the data in a comma separated values file format. 

The file will download. Note: If the file does not appear to download, make sure the popup blocker in 

your web browser is not blocking the file. 

Executive Reporting Module: Executive Reporting Dashboard 
The Executive Reporting Dashboard allows for customizable metrics to be selected from a menu of 

options. Any metrics defined will be saved for future use on the dashboard. 

1. Click the Executive Reporting Dashboard button. 
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The Executive Dashboard screen is displayed. 

 

The Executive Dashboard screen contains two menu items. 

 

The first menu item is Executive Reporting Home. This is a back button used to return you to the 

Executive Reporting Module home screen. 

 

Executive Reporting Module: Executive Reporting Dashboard > Edit 
The second menu item is enable edit mode. 

 

1. Click the enable edit mode menu item. Note: The enable edit mode menu item is located in the 

top right menu and in the body of the page. 

The Executive Dashboard edit screen displays four menu items. 

 

Executive Reporting Module: Executive Reporting Dashboard > Edit > Add Widget 
The first menu item is add new widget. 
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1. Click the Add New Widget menu item. 

2. The Add New Widget popup screen is displayed. 

a. Widget controls are located in the top right corner of a widget. 

b. All widgets require configuration prior to use. 

 

Widgets include: 

a. Base Case Comparison: Use this widget to compare a specific meter reading against the 

basecase. 

 

i. Base Case Comparison widget controls: 

1. Reload widget content. This control refreshes widget data. 
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2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

3. Edit widget configuration. This control provides access to the Base Case 

Comparison widget configuration screen. 

 

4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

ii. Base Case Comparison widget configuration: 

1. Enter a Title for the widget. 

2. Select the Basecase. 

3. Choose Group. 

4. Choose Hub. 

5. Choose Device. 

6. Choose Data Point. 

7. Choose Time Zone. 

8. Enter Date Format. 

9. Click the cancel button to discard changes OR 

10. Click the Apply button to save changes. 
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b. Carbon Footprint: Use this widget to display the carbon footprint report for a building 

or portfolio.  

 

iii. Carbon Footprint widget controls: 

1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 
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3. Edit widget configuration. This control provides access to the Carbon 

Footprint widget configuration screen. 

 

4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

iv. Carbon Footprint widget configuration: 

1. Enter a Title for the widget. 

2. Click radio box for Building or Portfolio. 

3. Select either Building or Portfolio base on the prior selection. 

4. Select Time Frame. 

5. Select Time Zone. 

6. Enter Data and Time Format. 

7. Enter data refresh intervals. 

8. Click the cancel button to discard changes OR 

9. Click the Apply button to save changes. 
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c. Clock: Use this widget to display date and time in a given time zone. 

 

v. Clock widget controls: 

1. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

2. Edit widget configuration. This control provides access to the Clock 

widget configuration screen. 
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3. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

vi. Clock widget configuration: 

1. Enter a Title for the widget. 

2. Select a Time Zone. 

3. Enter a Time pattern. 

4. Enter a Date pattern. 

5. Click the cancel button discard changes. 

6. Click the Apply button to save changes. 

 

d. Compare Data Points: This widget will help you to compare a set of data points over a 

period of time. 
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vii. Compare Data Points widget controls: 

1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

3. Edit widget configuration. This control provides access to the Compare 

Data Points widget configuration screen. 

 

4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

viii. Compare Data Points widget configuration: 

1. Enter a Title for the widget. 

2. Select first data point. 

a. Select Group. 
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b. Select Hub. 

c. Select Device. 

d. Select Data Point. 

3. Select second data point. 

a. Select Group. 

b. Select Hub. 

c. Select Device. 

d. Select Data Point. 

4. Select Time Frame. 

5. Select Time Zone. 

6. Enter Date Format. 

7. Enter the data refresh interval. 

8. Click the cancel button discard changes. 

9. Click the Apply button to save changes. 

 

e. Goal: Use this widget to compare the current value against the goal value for the 

building. 

 

ix. Goal widget controls. 
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1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

3. Edit widget configuration. This control provides access to the Goal 

widget configuration screen. 

 

4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

x. Goal widget configuration: 

1. Enter a Title for the widget. 

2. Select the Building. 

3. Select the Goal. 

4. Enter Date and Time format. 

5. Enter data refresh interval. 

6. Click the cancel button discard changes OR 

7. Click the Apply button to save changes. 
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f. Map: Set and display the map location of a building. 

 

xi. Map widget controls: 

1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

3. Edit widget configuration. This control provides access to the Map 

widget configuration screen. 
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4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

xii. Map widget configuration: 

1. Enter a Title for the widget. 

2. Click radio box for Building or Portfolio. 

3. Select either Building or Portfolio base on the prior selection. 

4. Enter data refresh interval. 

5. Click the cancel button discard changes OR 

6. Click the Apply button to save changes. 

 

g. Picture: Upload and display a picture. 
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xiii. Picture widget controls: 

1. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

2. Edit widget configuration. This control provides access to the Picture 

widget configuration screen. 

 

3. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

xiv. Picture widget configuration: 

1. Enter a Title for the widget. 

2. Enter a Description. 

3. Select image to upload. 

4. Click the cancel button to discard changes OR 

5. Click the Apply button to save changes. 
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h. Report: The ability to allocate cost (percentage) across all the data points or virtual data 

points of a HUB. 

 

xv. Report widget controls: 

1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 

 

3. Edit widget configuration. This control provides access to the Report 

widget configuration screen. 
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4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

xvi. Report widget configuration: 

1. Enter a Title for the widget. 

2. Click radio box for Badge or Chart. 

a. If Chart is clicked/pressed, select Chart Type. 

3. Click radio box for Building or Portfolio. 

4. Select the Building or Portfolio. 

5. Select the Report. 

6. Select the Time Frame. 

7. Select the Time Zone. 

8. Enter the Date and Time format. 

9. Enter the data refresh interval. 

10. Click the cancel button to discard changes OR 

11. Click the Apply button to save changes. 
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i. Weather: Weather information can be brought into the executive dashboard to cross-

reference weather data with the metrics.  

 

xvii. Weather widget controls: 

1. Reload widget content. This control refreshes widget data. 

 

2. Change widget location. This control allows you to reposition the widget 

in a layout for display. 
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3. Edit widget configuration. This control provides access to the Weather 

widget configuration screen. 

 

4. Remove widget. This control removes the widget from the executive 

dashboard. Note: Saved configuration settings are deleted with the 

widget. 

 

xviii. Weather widget configuration:  

1. Enter a Title for the widget. 

2. Select the Building. 

3. Enter data refresh interval. 

4. Click the cancel button to discard changes. 

5. Click the Apply button to save changes. 

 

Executive Reporting Module: Executive Reporting Dashboard > Edit > Edit 

Dashboard 
The second menu item is edit dashboard. 

1. Click the edit dashboard menu item. 

 

The edit dashboard popup screen is displayed. The edit dashboard popup screen provides you with the 

ability to add a title to the dashboard and to set the layout or structure of the dashboard. 
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Structured layouts include: 

a. 6-6                 2 Columns (50%, 50%) 

b. 4-8                 2 Columns (25%, 75%) 

c. 12/4-4-4         2 Rows (100%, 33%, 33%, 33%) 

d. 12/6-6            2 Rows (100%, 50%, 50%) 

e. 12/6-6/12       3 Rows (100%, 50%, 50%, 100%) 

f. 3/9 (12/6-6)    2 Columns, 2 Rows (25%, 75%, 37%, 37%) 

g. 4-4-4              3 Columns (33%, 33% 33%) 

h. 3-3-3-3           4 Columns (25%, 25%, 25%, 25%) 

i. 3-6-3              3 Columns (25%, 50%, 25%) 
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2. To add a title to the dashboard, click in the Title field and enter the title to be displayed on the 

Executive Dashboard. 

 

3. Click a structure icon to set the layout for the dashboard. 

4. Click the Close button.  

Executive Reporting Module: Executive Reporting Dashboard > Edit > Save 

 

The third menu item is save changes. Clicking the save changes icon will save all changes made to the 

executive dashboard and then set the executive dashboard screen in view mode. 

Executive Reporting Module: Executive Reporting Dashboard > Edit > Undo 

 

The fourth menu item is undo changes. Clicking/pressing the undo changes button will discard all 

changes made to the executive dashboard and then set the executive dashboard screen in view mode. 

Note: If edits have been made but the edits have not been saved and you are trying to navigate out of 

the screen, you will be prompted to save or discard changes. 

Executive Reporting Module: Executive Reporting Alerts Overview 
1. Click the Executive Reporting Alerts button. 



Using Building Manager Online 3.0 

141 | P a g e  

 

The Executive Reporting Alerts screen is displayed. 

 

The Executive Reporting Alerts screen contains two menu items and a table displaying a list of all alerts. 

The first menu item is Alerts. This is the default view. 

 

Executive Reporting Module: Executive Reporting Alerts > Add 
1. Click the Add New Alert button. 
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The Create Executive Reporting Alert page is displayed. 

 

2. Enter an Alert Name. 

3. Select an Alert Type. 

a. Demand (to ensure that the electrical load in question does not exceed a pre-

determined level, which can incur unintentional costs). 

b. Consumption (to remain within an energy budget for a specific date range) 

4. Enter a Base Value (defined as the threshold against which an alert is created, such as demand 

greater than or equal to 500kW). 

5. Select a Building.  

a. Available buildings are active buildings located in the Buildings list screen. 

6. Select a condition to be used when comparing a data point to the base value. 

a. Less than (<): An alert will trigger when the data point value is less than the base value. 
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b. Less than equal (<=): An alert will trigger when the data point value is less than or equal 

to the base value. 

c. Equal (=): An alert will trigger when the data point value is equal to the base value. 

d. Greater than equal (>=): An alert will trigger when the data point value is greater than or 

equal to the base value. 

e. Greater (>): An alert will trigger when the data point value is greater than the base 

value. 

7. Enter an Alert Message. 

8. Select an Alert Type. 

9. Select the Type of Notification. 

a. Text (an SMS text). You will receive alert information via text. 

b. Email (standard email address). You will receive alert information via email. 

c. Mobile (mobile app for BMO 3.0 Executive Reporting Module). You will receive an alert 

on the mobile app if the mobile app has been installed and configured. 

d. Notify once (single notification—user will not be notified if the condition reoccurs). 

10. Check the alert Active checkbox to make the alert inactive. 

11. Set the time of day. 

12. Select the days of the week. 

13. Select the months of the year. 

14. Select Group. 

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

15. Select Hub. 

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. Note: Available hub selections are based on the prior group 

selection. 

16. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  

c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

17. Select Data point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. Note: Available data point selections are based on the prior 

hub selection. 

18. Click the Go Back to Alerts List button or simply navigate out of the screen without clicking the 

Save button to discard changes. 

19. Click the Save button to save changes. The Alert is added to the Alerts list screen. 
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Executive Reporting Module: Executive Reporting Alerts > Edit 
1. Click the Edit link in the row of the alert located in the Actions column on the alerts list screen or 

simply click the name of the alert. 

 

From here, you can change: 

a. Name of the alert. 

b. Type of the alert. 

c. Base value of the alert. 

d. Change the selected building of the alert. 

e. Alert conditions. 

f. Alert message. 

g. The type of notification. 

h. Time of day of the alert. 

i. Days of Week of the alert. 

j. Months of Year of the alert. 

k. Selected group of the alert. 

l. Selected hub of the alert. 

m. Selected device of the alert. 

n. Selected data point of the alert. 

 

3. Make the necessary edits. 

4. Click the Back to Alerts List button or simply navigate out of the screen without clicking/pressing 

the Save button to discard changes. 

5. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Alerts > Remove 
1. Click the Edit link in the row of the alert located in the Actions column on the alerts list screen or 

simply click the name of the alert. 
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2. Click the Active checkbox to remove the alert from the executive reporting alerts list screen. 

 

3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the alert 

will no longer appear in the executive reporting alerts list screen and you will not be able to 

access the alert from other areas of the Building Manager Online 3.0. 

4. Click the Back to Alerts List button or simply navigate out of the screen without clicking/pressing 

the Save button to discard changes. 

5. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Alerts > Adding Removed Alerts 
1. To add a removed alert, click the Edit link in the row of the alert located in the Actions column 

on the executive reporting alerts list screen or simply click the name of the alert. 

 

2. Click the Active checkbox to add the alert back to the executive reporting alerts list screen. 
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3. Click the Back to Alerts List button or simply navigate out of the screen without clicking the Save 

button to discard changes. 

4. Click the Save button to save the change. 

Executive Reporting Module: Executive Reporting Alerts > Contacts > Add 
1. The second menu item is Contacts. Click the Contacts menu item. 

 

The Contacts list screen is displayed. 

 

The contacts screen displays a table containing a list of contacts. The contact table contains: 

a. The type of contact (Email, SMS Text). 

b. The value for the contact (Email Address for Email, Phone Number for SMS). 

c. The name of the building associated with the contact. 

d. The ability to De-Activate, Activate, or Delete a contact. 

 

2. Click the Add Contact Point button. 
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The Add a Contact Point window is displayed. 

 

3. Select the Contact Type. 

a. Email 

b. SMS (text) 

4. Enter the Contact Value (field displays after selecting the Contact Type). 

a. Enter email address when Email is selected as the Contact Type. 

b. Enter phone number when SMS is selected as the Contact Type. 

5. Select Building.  

a. Available buildings are active buildings located in the Buildings list screen. 

b. The default selection is All Buildings. 

c. Click the Limit Alerts to the Selected Building to select a building. 

d. Click the building. 

6. Click the Close button to discard changes OR 

7. Click the Add button. The contact is added to the Contact Points list. 

Executive Reporting Module: Executive Reporting Alerts > Contacts > 

Deactivate/Activate/Delete 
1. To Deactivate: Click the De-Activate link in the row of the contact point located in the Actions 

column on the contact points list screen. 
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2. To Activate: Click the Activate link in the row of the contact point located in the Actions column 

on the contact point list screen. 

 

3. To Delete: To delete a contact point, click the Delete link in the row of the contact point located 

in the Actions column on the contact points list screen. 

 

4. Click the Show Inactive checkbox to toggle the list between active and inactive contacts. Note: 

Deleted contacts are permanently removed from Building Manager Online 3.0. 

Executive Reporting Module: Executive Reporting Base Case Overview 
A base case is a baseline energy usage measurement at the data point level or virtual meter level. The 

measurement is based on energy cost and energy usage for a defined period of time. 

1. Click the Executive Reporting Base Case button. 
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The Executive Reporting Base Cases list screen is displayed. 

 

2. The Executive Reporting Base Cases screen contains a table displaying a list of all base cases. 

Executive Reporting Module: Executive Reporting Base Case > Add 
1. Click the Add New Base Case button. 

 

The Create Base Case screen is displayed. 

 

The Create Base Case screen contains two menu items, which are explained below. 

Executive Reporting Module: Executive Reporting Base Case > Add > Create Base Case from 

Meter 

The first menu item is Base Case from Meter. This is the default view. 

1. Click the Base Case from Meter menu item. 
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2. Enter Base Case Name. 

3. Select Building. 

a. Available buildings are active buildings located in the Buildings list screen. 

4. Select Base Cases Type. 

5. Select Utility. 

6. Select a range of data by clicking the date range picker. 

7. Select the time zone. 

8. Select Group. 

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

9. Select Hub. 

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. Note: Available hub selections are based on the prior group 

selection. 

10. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  

c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

11. Select Data point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. 

12. Click the Go Back to Base Cases button or simply navigate out of the screen to discard changes 

OR 

13. Click the Save button to save changes. The base is added to the Base Cases list screen. 

Executive Reporting Module: Executive Reporting Base Case > Add > User Entered Base 

Case 

The second menu item is User Entered Base Case. 

1. Click the User Entered Base Case menu item. 

 

2. Enter the Base Case Name. 
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3. Select Building. 

a. Available buildings are active buildings located in the Buildings list screen. 

4. Select Base Case Type.  

a. Cost (energy costs/kWh) 

b. Cost (Usage)/energy cost for square footage of building 

c. Demand (average—typical throughout the day in kWh) 

d. Demand (highest load in kWh at any given time) 

e. Usage (how much energy used in kWh) 

f. Usage (Consumption)/ energy usage for square footage of building 

5. Select Utility—gas, water, electric 

6. Enter base case value. 

7. Choose base case units (kWh, gallons, etc.) 

8. Enter length of time (days). 

9. Click the Go Back to Base Cases button or simply navigate out of the screen to discard changes. 

10. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Base Case > Edit 
1. Click the Edit link in the row of the base case located in the Actions column on the executive 

reporting base cases list screen or simply click the name of the base case. 

 

The edit base case screen is displayed. 
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From this screen you can change: 

a. Base Case Name. 

b. Selected building. 

i. Available buildings are active buildings located in the Buildings list screen. 

c. Selected date range. 

d. Selected group. 

i. Groups are located in the System Network and added, edited, and removed 

through the base module. 

e. Selected hub. 

i. Hubs are child objects to groups. 

ii. Hubs are located below groups in the System Network and added, edited, and 

removed through the base module. 

iii. Note: Available hub selections are based on the prior group selection. 

f. Selected device. 

i. Devices are child objects to hubs. 

ii. Devices are located below hubs in the System Network.  
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iii. As long as a device is physically connected to a hub and the hub is uploading 

data to the Building Manager Online 3.0, the Building Manager Online 3.0 will 

receive data from the hub for the device. 

g. Selected data point. 

i. Data Points are child objects to devices which are child objects to hubs. 

ii. Data Points are located in the System Network under Group > Hubs > Devices. 

Each device contains data points. 

2. Make the necessary edits. 

3. Click the Back to Base Cases button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

4. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Base Case > Remove 
1. Click the Edit link in the row of the base case located in the Actions column on the executive 

reporting base cases list screen or simply click the name of the base case. 

 

2. Click the Active checkbox to remove the alert from the executive reporting base cases screen. 

 

3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the base 

case will no longer appear in the executive reporting base cases list screen and you will not be 

able to access the base case from other areas of the Building Manager Online 3.0. 

4. Click the Back to Base Cases button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

5. Click the Save button to save the change. 

Executive Reporting Module: Executive Reporting Base Case > Adding Removed 

Base Case 
1. To add a removed base case, click the Edit link in the row of the base case located in the Actions 

column on the executive reporting base cases list screen or simply click the name of the base 

case. 
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2. Click the Active checkbox to add the base case back to the executive reporting base cases list 

screen. 

 
3. Click the Back to Base Cases button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

4. Click the Save button to save the change. 

Executive Reporting Module: Executive Reporting Building Goals Overview  
Executive reporting building goals allows the ability to set goals for usage/consumption at the building 

level based on the base case. 
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1. Click the Executive Reporting Building Goals button. 

 

The building goal list screen is displayed. 

 

The building goal list screen displays a table containing a list of all building goals. 

Executive Reporting Module: Executive Reporting Building Goals > Add 
1. Click the Add New Building Goal button. 
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The Create Building Goal list screen is displayed. 

 

2. Enter the Goal Name. 

3. Select a Base Case. Note: A base case must be added to the Building Manager Online 3.0 prior to 

adding a goal. 

4. The Building field is populated with the building selected from the base case. 

5. The Base Case Value field is populated with the base case value defined in the base case. 

6. Set the goal percentage. The default value is 5, indicating a 5% reduction. 

7. Set the warning percentage. The default value is 5, indicating a 5% buffer below the actual goal 

value.  

8. Set the critical percentage. The default value is 5, indicating a 5% buffer above the actual goal 

value. 

a. Change the selected group. 

i. Groups are located in the System Network and added, edited, and removed 

through the base module. 

b. Change the selected hub. 

i. Hubs are child objects to groups. 

ii. Hubs are located below groups in the System Network and added, edited, and 

removed through the base module. 

iii. Note: Available hub selections are based on the prior group selection. 
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c. Change the selected device. 

i. Devices are child objects to hubs. 

ii. Devices are located below hubs in the System Network.  

iii. As long as a device is physically connected to a hub and the hub is uploading 

data to the Building Manager Online 3.0, the Building Manager Online 3.0 will 

receive data from the hub for the device. 

d. Change the selected data point. 

i. Data Points are child objects to devices which are child objects to hubs. 

ii. Data Points are located in the System Network under Group > Hubs > Devices. 

Each device contains data points. 

9. Click the Cancel button or simple navigate out of the screen without clicking the Save button to 

discard changes OR 

10. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Building Goals > Edit 
1. Click the Edit link in the row of the goal located in the Actions column on the building goal list 

screen or simply click the name of the goal. 

 

The Edit Building Goal screen is displayed. 
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From this screen you can: 

a. Edit the Goal Name. 

b. Change the selected Base case. 

i. Selected Base Case value drives the Building field and the Base Case Value field. 

c. Change the Goal Percentage. 

d. Change the Warning Percentage. 

e. Change the Critical Percentage. 

f. Change the selected group. 

i. Groups are located in the System Network and added, edited, and removed 

through the base module. 

g. Change the selected hub. 

i. Hubs are child objects to groups. 

ii. Hubs are located below groups in the System Network and added, edited, and 

removed through the base module. Note: Available hub selections are based on 

the prior group selection. 

h. Change the selected device. 

iii. Devices are child objects to hubs. 

iv. Devices are located below hubs in the System Network.  



Using Building Manager Online 3.0 

159 | P a g e  

v. As long as a device is physically connected to a hub and the hub is uploading 

data to the Building Manager Online 3.0, the Building Manager Online 3.0 will 

receive data from the hub for the device. 

i. Change the selected data point. 

vi. Data Points are child objects to devices which are child objects to hubs. 

vii. Data Points are located in the System Network under Group > Hubs > Devices. 

Each device contains data points. 

2. Make the necessary edits. 

3. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes. 

4. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Building Goals > Remove 
1. Click the Edit link in the row of the goal located in the Actions column on the building goal list 

screen or simply click the name of the goal. 

 

The Building Goal screen is displayed. 
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2. Click the Active checkbox to remove the goal from the building goal list screen. 

 
3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the goal 

will no longer appear in the building goal list screen and you will not be able to access the goal 

from other areas of the Building Manager Online 3.0. 

4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Executive Reporting Module: Executive Reporting Building Goals > Adding a 

Removed Goal 
1. To add a removed goal, click the Edit link in the row of the base case located in the Actions 

column on the building goal list screen or simply click the name of the goal. 

 

2. The Building Goal screen is displayed. 
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3. Click the Active checkbox to add the goal back to the building goal list screen. 

 
4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module:  
The tenant billing module allows for meter reading and invoice creation for tenants in any commercial 

or residential multi-unit building. 

 

 The Tenant Billing module is an expansion module and must be purchased. 

 If you are interested in purchasing the Tenant Billing module, see Modules Menu > Purchase 

Modules. 
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1. If purchased, click Modules > click Tenant Billing. 

 

The Tenant Billing module is displayed. The Tenant Billing module contains five menu items: 

a. Building Setup. 

b. Tenant Setup. 

c. Virtual Meters. 

d. Tariffs. 

e. Generate Bills. 
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Tenant Billing Module: Building Setup  
1. Click the Building Setup button. 

 

The Buildings list screen is displayed. 
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The Buildings list screen displays a map pinpointing the location for each building added to the Building 

Manager Online 3.0 and contains a table listing all buildings added to the Building Manager Online 3.0. 

Tenant Billing Module: Building Setup > Add New Building 
1. Click the Add New Building button. 

 

The Add Building screen is displayed. 

 

2. Enter building attributes.  

a. Name of the Building 

b. Address Line 1 

c. Address Line 2 (optional) 

d. City 

e. State 

f. Zip Code 

g. Country 

3. Click the Cancel button to discard changes OR 

4. Click the Save button to add the building to the Buildings list screen. 
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Tenant Billing Module: Building Setup > Edit Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

The Edit Building screen is displayed. 

 

Note: Using the Building Edit Option unlocks the following screen functionality: 

a. Disclaimer (user may create a disclaimer relevant to their particular corporation, such as 

disclaimer related to tenant bills, utility prices, etc.) 

b. Commodity References (may refer to gas usage in CCFs, etc.) 

c. Mail to/Remit Information (address that tenant sends bill payment back to) 

d. Bill Logo Image (customizable area to include company’s logo image on bill) 

e. The Ability to add Tariffs (a rate structure used for billing energy to end users. Tenant 

Billing Module allows for the creation of tariff as desired by end user; formats offered 
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are simple tiered tariff and TOU tariff.) 

 

2. Click the field to be modified. 

3. Enter changes. 

4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Remove Building 
1. Click the Edit link in the row of the building located in the Actions column on the Buildings list 

screen or simply click the name of the building. 

 

The Edit Building screen is displayed. 

 

2. Click the Active checkbox to remove the building from the Buildings list screen. 
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3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

building will no longer appear in the Buildings list screen and you will not be able to access the 

building from other areas of the Building Manager Online 3.0. 

4. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Adding a Removed Building 
1. To add a removed building, click the Edit link in the row of the building located in the Actions 

column on the Buildings list screen or simply click on the name of the building. 

 

The Edit Building screen is displayed. 
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2. Click the Active checkbox to add the building back to the Buildings list screen. 

 

3. Click the Cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

4. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Units 
1. Click the Units link in the row of the building located in the Actions column on the Buildings list 

screen. 

 

The List of Building Units screen is displayed. 

 

2. The List of Building Units screen displays the name of the building, the address of the building, 

and a table containing all units added to the building. 

Tenant Billing Module: Building Setup > Units > Add 
1. Click the Add Unit button. 
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The Add a Building Unit screen is displayed. 

 

The Add a Building Unit screen displays the name of the building and the address of the building. 

2. Enter the Unit Number. 

3. Enter a Description for the Unit (optional). 

4. Click the Back to Units button or simply navigate out of the screen without clicking the Save 

button to discard changes. 

5. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Units > Edit 
1. Click the Edit link in the row of the unit # located in the Actions column on the List of Building 

Units screen. 

 

The Edit Building screen is displayed. 
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2. Click the field to be modified. 

3. Enter changes. 

4. Click the Back to Units button or simply navigate out of the screen without clicking the Save 

button to discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Units > Remove 
1. Click the Edit link in the row of the unit # located in the Actions column on the List of Building 

Units screen. 
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The Edit Building screen is displayed. 

 

2. Click the Active checkbox to remove the unit from the List of Building Units screen. 

 
3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

building will no longer appear in the List of Building Units screen and you will not be able to 

access the unit from other areas of the Building Manager Online 3.0. 

4. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Units > Adding a Removed Unit 
1. To add a removed unit, click the Edit link in the row of the unit # located in the Actions column 

on the List of Building Units screen. 
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The Edit Building screen is displayed. 

 

2. Click the Active checkbox to add the unit back to the List of Building Units screen. 

 
3. Click the cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes OR 

4. Click the Save button to save changes. 

Tenant Billing Module: Building Setup > Units > Assign Meter 
1. Click the Assign meter link in the row of the unit # located in the Actions column on the List of 

Building Units screen. 
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The Meter Assigned to Unit screen is displayed. 

 

 The Meter Assigned to Unit screen displays the name of the building, the address of the 

building, and a table containing a list of utilities.  

 This screen allows you to assign a data point (from a submeter) to a matching utility (e.g., BTU, 

kWh, etc.). 

 
 

2. Click the Assign button and then select a utility option. 

The Assign Meter screen is displayed. 
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The Assign Meter screen displays the name of the building and the address of the building. 

3. Enter a Name. 

a. This will help you keep track of assignments. 

4. Select Group.  

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

9. Select Hub.  

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. 

c. Note: Available hub selections are based on the prior group selection. 

10. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  

c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

11. Select Data Point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. Note: Available data point selections are based on the prior 

hub selection.  

12. Enter a Percentage. (percentage of meter value assigned to the particular tenant) 

13. Click the Back to Assigned Meters button or simply navigate out of the screen without clicking 

the Save button to discard changes OR 

14. Click the Save button to assign the meter. 
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Tenant Billing Module: Building Setup > Units > Edit 
1. Click the Edit link in the row of the assigned meter in the Meter Assigned to Unit screen. 

 

The Assign Meter screen is displayed. 

 

2. Click the field to be modified. 

3. Enter changes. 

4. Click the Back to Assigned Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes OR 

5. Click the Save button to save changes. 

 

Tenant Billing Module: Building Setup > Units > Unassign Meter 
1. Click the Edit link in the row of the assigned meter in the Meter Assigned to Unit screen. 
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The Assign Meter screen is displayed. 

2. Click the Back to Assigned Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes. 

3. Click the Unassign button. 
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Tenant Billing Module: Tenant Setup 
1. Click the Tenant Setup button. 

 

2. The Tenants list screen is displayed. 

 

3. The Tenants list screen displays a table containing a list of all tenants. 

4. You can filter tenants by building.  

 

5. Click the My Buildings button to view all available buildings. Note: You will be redirected to the 

Building Setup screen. You can navigate back to the Tenant Setup screen by clicking/pressing 

Modules > Tenant Billing > Tenant Setup. 

Tenant Billing Module: Tenant Setup > Add Tenants 
1. Click the Add New Tenant button. 
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The Add Tenant screen is displayed. 

 

2. Enter Tenant Name. 

3. Select a Building (buildings are populated by buildings listed under Modules > Tenant Billing > 

Building Setup). 

4. Select a Unit (this selection is populated by the Units list screen under Modules > Tenant Billing 

> Building Setup > Building - Units). 

5. Enter Phone Number. 

6. Enter Email Address. 

7. Select Move In Date. 

8. Select Move Out Date. 
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9. Note: Move In and Move Out dates for multiple customers occupying an open unit cannot 

overlap. 

a. If customer A has a move in date of 3/1/xx and a move out date of 9/30/xx, the unit 

cannot be selected for customer B on 4/1/xx, 5/1/xx, etc.  

10. Select Pay By Day of Month. (date by which the bill needs to be paid to management) 

11. Set a Grace Period. (number of days payment is permitted after the Pay By date) 

12. Click the cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes. 

13. Click the Save button to save changes. 

 

Tenant Billing Module: Tenant Setup > Edit Tenants 
1. Click the Edit link in the row of the tenant in the Actions column on the Tenants list screen. 

 

The Edit Tenant screen is displayed. 

 

2. Click the field to be modified. 

3. Enter changes. 
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4. Click the cancel button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Virtual Meters 
Virtual meters allow you to add or subtract real data points to produce virtual data points. You can only 

create virtual meters from real data points of the same type such as kW, Degree F, etc. Only hubs with a 

data upload interval of 15 minutes can be used to create Virtual meters.  
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1. Click the Virtual Meters button. 

 

2. The Virtual Meters list screen is displayed. 

 

 The Virtual Meters list screen contains a table listing all virtual meters added to the Building 

Manager Online 3.0. 

 The Virtual Meters list screen contains a table and two main navigational menu items. 

 The table lists all Virtual Meters added to the Building Manager Online 3.0. 

 The two navigational menu items are Add New Virtual Meter and Home. 

 The Virtual Meters list screen allows you to filter your virtual meters by Building. 

 

 

Tenant Billing Module: Virtual Meters > Add 
1. Click the Add New Virtual Meter button. 
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The Create Virtual Meter screen is displayed. 

 

2. Enter Virtual Meter Label.  

a. This will be the name of the Virtual Meter. 

3. Select Group.  

a. Groups are located in the System Network and added, edited, and removed through the 

base module. 

4. Select Hub.  

a. Hubs are child objects to groups. 

b. Hubs are located below groups in the System Network and added, edited, and removed 

through the base module. Note: Available hub selections are dependent upon and 

based on the prior group selection. 

5. Select Device. 

a. Devices are child objects to hubs. 

b. Devices are located below hubs in the System Network.  

c. As long as a device is physically connected to a hub and the hub is uploading data to the 

Building Manager Online 3.0, the Building Manager Online 3.0 will receive data from the 

hub for the device. 

6. Select Data Point. 

a. Data Points are child objects to devices which are child objects to hubs. 

b. Data Points are located in the System Network under Group > Hubs > Devices. Each 

device contains data points. Note: Available data point selections are based on the prior 

hub selection. 

The selected data point will display in the Virtual Calculations definition/formula box. 
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The selected data point will also display below the Virtual Data Point Definition heading. 

 

Note: A virtual meter equation is also known as a virtual meter definition. 

7. Click the appropriate mathematical operator. 

a. Plus sign (+) 

i. The plus sign (+) will add the selected data point value to the next data point 

value. 
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b. Subtraction sign (-) 

i. The subtraction sign (-) will subtract the next data point value from the selected 

data point value. 

 

8. Clear button (Ø). 

a. Click the clear button to remove elements from a Virtual Calculations definition. Note: 

The clear button will only remove a data point or operator at the end of a 

definition/equation. 

b. Click the last data point or operator in the definition/equation. 

c. Click the clear button. 
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9. Click the data point dropdown and click the next data point. Note: The data point dropdown 

field is used for selecting the initial data point and each additional data point. 

 
10. Repeat adding data points and mathematical operators until the definition is complete. 

a. Process for Building Virtual Meters: 

i. Step 1 Select Data Point. 

ii. Step 2 Select Mathematical Operator. 

iii. Step 3 Select Data Point. 

Note: Virtual Meters must be of the same type (e.g., kW, Degree F, etc.). 
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Also note: Like data points can be added and subtracted from different groups, hubs, and virtual meters. 

b. Process for Building Virtual Meters using multiple hubs: 

i. Step 1 Select Data Point 

ii. Step 2 Select Mathematical Operator 

iii. Step 3 Select Group 

iv. Step 4 Select Hub 

v. Step 5 Select Data Point 

 

11. Click the Back to Virtual Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes. 

12. Click the Reset Selections button to clear the screen and start over. 

13. Click the Save button to save the virtual meter. The Virtual Meters list screen is displayed and 

the newly created virtual meter is listed. 

 

Tenant Billing Module: Virtual Meters > Edit 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 

 

The Edit Virtual Meter screen is displayed. 
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From this screen you can: 

a. Change the label (name) of the meter. 

b. Select additional groups. 

c. Select additional hubs (must first select the group). 

d. Select additional data points (must first select the hub). 

e. Add and remove data points and operators to and from the Virtual Data Point 

Definition. 

2. Make the necessary edits. 

3. Click the Back to Virtual Meters button or simply navigate out of the screen without 

clicking/pressing the Save button to discard changes. 

4. Click the Reset Selections button to clear the screen and start over. 

5. Click the Save button to save changes. 

Tenant Billing Module: Virtual Meters > Remove 
1. Click the Edit link in the row of the virtual meter located in the Actions column on the Virtual 

Meters list screen or simply click the name of the virtual meter. 

 

The Edit Virtual Meter screen is displayed. 
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2. Click the Active checkbox to remove the virtual meter from the virtual meter list screen. 

 

3. When the checkbox is empty (doesn’t contain a check) and the screen has been saved, the 

virtual meter will no longer appear in the virtual meter list screen and you will not be able to 

access the virtual meter from other areas of the Building Manager Online 3.0. 

4. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

5. Click the Save button to save changes. 

Tenant Billing Module: Virtual Meters > Adding a Removed Virtual Meter 
1. To add a removed virtual meter, click the Edit link in the row of the virtual meter located in the 

Actions column on the virtual meter list screen or simply click the name of the virtual meter. 
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The Edit Virtual Meter screen is displayed. 

 

2. Click the Active checkbox to add the virtual meter back to the virtual meters list screen. 

 

3. Click the Back to Virtual Meters button or simply navigate out of the screen without clicking the 

Save button to discard changes OR 

4. Click the Save button to activate the virtual meter. 

Tenant Billing Module: Virtual Meters > View Data 
1. Click the View Data link in the Actions column of the virtual meter list screen. 
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The view data screen is displayed. 

 

 The view data screen displays the name of the virtual meter, the definition (equation) used to 

calculate the virtual data points. 

 The view data screen displays three menu items: 

 

 The first menu item is view data.  

 This is the default view for a virtual meter. 

 The view data screen displays a table containing all data and virtual data points for the 

selected date range. 

 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Select the time zone. 

8. Click the Update Table Data button. 
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The data table will refresh based on the selections. 

9. Scroll down to the bottom of the screen to page through data. 

 

10. Click the Update Table Data button to populate the table with data whenever the date range or 

time zone is changed. 

 

Tenant Billing Module: Virtual Meters > Graph 
1. Click the Graph link in the virtual meters list screen under the Actions column. 

 

Graph is the second menu items. 

 

The graph screen displays the name of the virtual meter and the definition (equation) used to calculate 

the virtual data points. 
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 A default date range is selected and a default graph is rendered. 

 The graph screen allows you to set a date range and select a time zone. 

 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 

4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Select the time zone. 

8. Click the Update Graph button. 

 

The graph is rendered. 
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9. Hover over the data points to view detailed information for each input. 

 

10. Hover over the graph and click and then drag and release to zoom in. 

 

11. Press the Reset zoom button to reset the zoom on the graph. 
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12. Click the Update Graph button to render the graph whenever the date range or time zones are 

changed. 

 

Tenant Billing Module: Virtual Meters > Export 
1. Click the Export link located in the virtual meters list screen under the Actions column. 

 

Export Data is the third menu item. 

 

The Export Data screen is displayed. 

 

 The export data screen displays the name of the virtual meter and the definition (equation) used 

to calculate the virtual data points. 

 The export data screen allows you to select a date range and time zone and then export the 

data to a text file. 

 

2. Select a range of data by clicking/pressing the date range picker. 

3. Select a start date. 
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4. Select an end date. 

5. Click the Apply button. 

6. Select the time zone by clicking/pressing the time zone dropdown. 

7. Select the time zone. 

8. Click the Excel (xls) button to export the data in an xls file format OR 

 

9. Click the Excel (xlsx) button to export the data in an xlsx file format OR  

10. Click the CSV button to export the data in a comma separated values file format OR 

The file will download. If the file does not appear to download, make sure the popup blocker in your 

web browser is not blocking the file. 

Tenant Billing Module: Tariffs 
1. Click the Tariffs button. 
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The Tariffs list screen is displayed. 

 

The Tariffs list screen contains 3 menu items and a table containing a list of all tariffs. The first menu 

item is Generate Bills. This is a shortcut to the Generate Bills section. 

 

The second menu item is Tenant Reports. This is a shortcut to the Tenant Reports section. 

 

The third menu item is tariffs. This is the default screen. 

 

Click the All Tariff Types dropdown and click Simple/Tiered or Time of Day (TOD) to filter the list of 

tariffs. 

 

Tenant Billing Module: Tariffs > Add Simple Tier 
1. Click the Add New Simple Tier button. 
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2. Tariff Identify. Enter Tariff Details. Traiff names make it easier for users to activate and 

deactivate tariffs as required. 

a. Enter Tariff Name. 

b. Enter Tariff Nick Name. 

c. Note: The screen will display the Tariff Version number. 

d. Click the Cancel button to discard changes. 

e. Click Continue to proceed to the next step. 

3. Energy Usage. Create tiers for energy usage charge calculations. Set a start value, end value, and 

rate for each tier. The last tier should have a start value, infinity as an end value, and a rate. 

Tiered tariffs allow for different costs at certain levels of usage (for example 0-100 kWh may be 

5 cents per kWh, while 101-200 kWh may be 7 cents, etc.). 

a. Enter End Value (kWh value defined by utility for the end user to pull data from master 

utility bill). 

b. Enter Rate. 

c. Click the Add Tier button to add another tier. 

d. Enter End Value. (allowing you to add as many values as the utility requires) 

e. Enter Rate. 

f. Repeat adding end values and rates to add tiers. 

g. Click the minus sign (-) to remove tiers. 

h. Click the Back button to return to the previous step. 

i. Click the Cancel button to discard changes and exit the tariff setup process. 

j. When finished adding tiers, click the Continue button to proceed to the next step. Note: 

In order to click the Continue button and proceed to the next step the end value for the 

last tier must be set to the default value of Infinity. 

4. Peak Demand Charges. Create tiers for peak demand charge calculations. Set a start value, end 

value, and rate for each tier. The last tier should have a start value, infinity as an end value, and 

a rate. This allows the end user to charge certain amounts for demand per kWh based on the 

stepped demand approach. 

a. Enter End Value. (define what this is and what the format of the value is/are there any 

rules) 

b. Enter Rate. 

c. Click the Add Tier button to add another tier. 

d. Enter End Value. (define what this is and why the user has to enter another tier/are 

there any rules) 

e. Enter Rate. 

f. Repeat adding end values and rates to add tiers. 

g. Click the minus sign (-) to remove tiers. 

h. Click the Back button to return to the previous step. 

i. Click the Cancel button to discard changes and exit the tariff setup process. 
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j. When finished adding tiers, click the Continue button to proceed to the next step. Note: 

In order to click the Continue button and proceed to the next step the end value for the 

last tier must be set to the default value of Infinity. 

5. Other Utility Charges (Optional). Setup charges for up to 4 other utilities below. Set a charge 

name, choose a utility, and set a rate. Each utility can only be used once. Other utilities may 

include gas, water, etc. 

a. Click the Add Utility Charges button. 

b. Enter a Charge Name (such as “Water Charges”). 

c. Select a Utility (water, gas, etc.). 

d. Enter a Rate. 

e. Repeat steps to add other utility charges. 

f. Click the minus sign (-) to remove rows. 

g. Click the Back button to return to the previous step. 

h. Click the Cancel button to discard changes and exit the tariff setup process. 

i. Click the Continue button to proceed to the next step. 

6. Custom Charges (Optional). Define up to 10 custom charges below. Set the charge type, 

quantity (if applicable) and rate. These custom charges could be taxes, distribution charges, or 

other custom fees as defined by the user. 

a. Click the Add Custom Charges button. 

b. Enter a Charge Name (such as “Tax”). 

c. Select a Charge Type (such as “New York Excise Tax”). 

d. Select a Quantity (if applicable) (can be percentage of bill or fixed amount). 

e. Enter a Rate. 

f. Repeat steps to add other custom charges. 

g. Click the minus sign (-) to remove tiers. 

h. Click the Back button to return to the previous step. 

i. Click the Cancel button to discard changes and exit the tariff setup process. 

j. Click the Continue button to proceed to the next step. 

7. Save the Tariff.  

a. Click the Back button to return to the previous step.  

b. Click the Cancel button to discard changes and exit the tariff setup process. 

c. Click the Save button to complete the setup. 

Tenant Billing Module: Tariffs > Add TOD 
1. Click the Add New TOD button. 

 

2. Tariff Identify. Enter Tariff Details. Select something easy to remember and intuitive to the 

tariff, such as “Summer Tarriff.” 

a. Enter Tariff Name. 

b. Enter Tariff Nick Name. 

c. Note: The screen will display the Tariff Version number. 
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d. Select a date range by clicking/pressing the date range picker. 

e. Click a start date. 

f. Click an end date. 

g. Click the Apply button. 

h. Click the Cancel button to discard changes and exit the tariff setup process. 

i. Click Continue to proceed to the next step. 

3. TOD kWh Usage. Define date range tiers for this tariff. Time-of-use tariffs charge different rates 

for different times of the day that power is used. 

a. Select Period Name 

i. On-Peak (time as defined by utility when usage is at its most high). 

ii. Mid-Peak (time as defined by utility when usage is in its mid-range). 

iii. Off-Peak (time as defined by utility when usage is at its lowest). 

b. Select a date range by clicking/pressing the date range picker. 

i. Click a start date. 

ii. Click an end date. 

iii. Click the Apply button. 

c. Select Start Day as defined by utility. 

1. Monday 

2. Tuesday 

3. Wednesday 

4. Thursday 

5. Friday 

6. Saturday 

7. Sunday  

d. Select End Day. 

1. Monday 

2. Tuesday 

3. Wednesday 

4. Thursday 

5. Friday 

6. Saturday 

7. Sunday  

e. Select Start Time. 

f. Select End Time. 

g. Enter Rate. 

h. Click the Add Tier button to create rows. 

i. Repeat steps when adding rows. 

j. Click the minus sign (-) to remove rows. 

k. Click the Cancel button to discard changes and exit the tariff setup process. 

l. Note: The Step 1 tariff date range must be completely covered in order to move on to 

step 3. All time must be accounted for. 

i. For example: 

1. Step 1 date range is set for January to December. 
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2. Define Tier 1 period, date range, start day, end day, start time, end 

time, and rate to cover January through March. 

3. Define Tier 2 period, date range, start day, end day, start time, end 

time, and rate to cover June through December. 

4. This is not complete because April and May are not accounted for. 

m. Click the minus sign (-) to remove rows. 

n. Click the Back button to return to the previous step. 

o. Click Continue to proceed to the next step. 

4. TOD kW Usage. Select a period, and set a rate for demand charge calculations. Each period can 

only be used once. This time is set by the utility. 

a. Select Period Name. 

b. Enter Rate. 

c. Click the Add Tier button to add Tiers. 

d. Click the minus sign (-) to remove rows. 

e. Click the Back button to return to the previous step. 

f. Click the Continue button to proceed to the next step. 

5. Peak Demand Charges. Create tiers for peak demand charge calculations. Set a start value, end 

value, and rate for each tier. The last tier should have a start value, infinity as an end value, and 

a rate. This time is set by the utility. 

a. Enter End Value. 

b. Enter Rate. 

c. Click the Add Tier button to add Tiers. 

d. Click the Back button to return to the previous step. 

e. Click the Continue button to proceed to the next step. 

6. Other Utility Charges (Optional). Setup charges for up to 4 other utilities below. Set a charge 

name, choose a utility, and set a rate. Each utility can only be used once. 

a. To add utility charges, click the Add Utility Charges button. 

b. Enter Charge Name. 

c. Select Utility. 

d. Enter Rate. 

e. Click the minus sign (-) to remove rows. 

f. Click the Back button to return to the previous step. 

g. Click the Continue button to proceed to the next step. 

7. Custom Charges (Optional). Define up to 10 custom charges below. Set the charge type, 

quantity (if applicable) and rate. 

a. To add custom charges, click the Add Custom Charge button. 

b. Select the Charge Type. 

i. Fixed 

ii. Percentage 

iii. Per/Day * Requires a Quantity to be selected. 

c. Select Quantity where applicable. 

d. Enter Rate. 

e. Click the Add Custom Charge button to add additional charges. 

f. Click the minus sign (-) to remove rows. 
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g. Click the Back button to return to the previous step. 

h. Click the Continue button to proceed to the next step. 

8. Holidays (Optional). Select Holidays. On these days, off peak charges will apply for the whole 

day. Custom Holidays can also be added below. Holidays defined outside the range of the tariff 

will not be taken into account when the bill is generated. 

a. Click the checkbox to select the holiday. 

b. Click the Add Custom Holidays button to add custom holidays. 

i. Enter a name for the holiday. 

ii. Select a date for the holiday. 

iii. Click the Add Custom Holidays button to add another custom holiday. 

c. Click the Back button to return to the previous step. 

d. Click the Continue button to proceed to the next step. 

9. Save the Tariff.  

a. Click the Back button to return to the previous step. 

b. Click the Cancel button or simply navigate out of the screen without clicking/pressing 

the Save button to discard changes. 

c. Click the Save button to save the TOD tariff. 

Tenant Billing Module: Tariffs > Edit 
1. Click the Edit link in the row of the tariff name located in the Actions column on the Tariffs list 

screen. 

 

Step 1 of the tariff is displayed. 
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2. Click the Continue button to proceed through steps. 

3. Make the necessary edits. 

4. Click the Back button to return to previous steps. 

6. Click the cancel button or simply navigate out of the screen without clicking/pressing the Save 

button to discard changes. 

7. Click the Save button to save changes. 

Tenant Billing Module: Tariffs > Deactivate 
1. Click the Deactivate link in the row of the tariff name located in the Actions column on the 

Tariffs list screen. 

 

A confirmation message is displayed. 
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2. Click the cancel button to cancel OR 

3. Click the OK button to proceed. 

Note: The tariff will not be accessible from other areas of the Building Manager Online 3.0. 

Tenant Billing Module: Tariffs > Activating a Deactivated Tariff 
1. Click the Show Inactive checkbox. 

 

2. Locate the Tariff. 

3. Click the Activate link in the row of the tariff name located in the Actions column on the Tariffs 

list screen. 

 

4. A confirmation message is displayed. 

 

5. Click the Cancel button to cancel OR 

6. Click the OK button to proceed. 

7. The tariff will once again be accessible from other areas of the Building Manager Online 3.0. 

Tenant Billing Module: Generate Bills 
1. Click the Generate Bills button. 
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The Generate Bills screen is displayed. 

 

The Generate Bills screen contains three menu items: 
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The Generate Bills screen is the first menu item and the default view. 

To generate a bill: 

1. Select a building 

2. Click the Generate Bill button. Warning messages are displayed on screen. If you cannot 

click the Generate Bill button, the warning message will direct the user to the corrective 

action.  

 

a. Select the data range for the billing cycle. 

b. Click the Generate button. 



Using Building Manager Online 3.0 

206 | P a g e  

 

Confirmation message will be displayed. 
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c. Click the Close button. 

 

The Bill will display as queued. 

 

d. Click the Refresh Status button to see if the bill has finished processing. 

 

 When the bill has finished processing, the Status column will display “Success.” 
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e. Bill export options are displayed in the Actions column. Bills can be exported as .PDF 

files individually or as a portfolio of all bill generated for that building.  

 

Reports is the second menu item. This is a shortcut to the Tenants Report screen. 

 

2. Click the Tenant Reports menu item. 

a. The Tenant Reports screen is displayed. A list of summary management reports are 

useful to managers administering tenant billing programs. Reports summarize tenant, 

utility information, tenant usage and costs. 
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b. Click the View Data link in the Actions column to view each report type. 

Tariffs is the third menu item. This is a shortcut to the Tariffs screen. 

 

Owning multiple modules 
Building Manager Online 3.0 functionality is updated when an expansion module is unlocked. 

Changes include: 

 An updated Building Manager Online 3.0 home screen Dashboard.  

 Purchased modules are added to the dashboard. 

 New Menu Items. 

 Enhanced screen functionality. 
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Purchased modules are added to the Modules menu. 
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All purchased module functions are added to the Wizards menu. 

 

 

 Shared functions such as Virtual Meters or Buildings are combined as singular menu items. 

 Combined functions will display functionality reflecting all functions. 
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Example: 

Building Setup for Code Compliance Module 
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Building Setup for Executive Reporting Module (Square Footage field is added) 
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Building Setup for Tenant Billing Module 

Note: Using the Building Edit Option unlocks screen functionality: 

a. Disclaimer (user may create a disclaimer relevant to their particular corporation, such as 

disclaimer related to tenant bills, utility prices, etc.) 

b. Commodity References (may refer to gas usage in CCFs, etc.) 

c. Mail to/Remit Information (address that tenant sends bill payment back to) 

d. Bill Logo Image (customizable area to include company’s logo image on bill) 

e. The Ability to add Tariffs (a rate structure used for billing energy to end users. Tenant 

Billing Module allows for the creation of tariff as desired by end user; formats offered 

are simple tiered tariff and TOU tariff) 
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Building Setup with all modules unlocked. 
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Support 
1. Click Support. 

 
2. The support screen is displayed.  

 

 
3. The support screen provides contact information for customer service and technical support. 

4. All instructional videos for the Building Manager Online 3.0 are listed on the support screen. 
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Modules Menu 
The modules menu allows you to jump between the base module and other purchased modules. 

1. Click modules. There will be two menu items if you do not own any of the expansion modules. 

 

Additional menu items will become visible with the purchase of expansion modules. 

 

Expansion modules include: 

a. Code Compliance module 

b. Executive Reporting module 

c. Tenant Billing module 

Modules Menu > Purchasing Modules 
The last menu item is Purchase Modules. 
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1. This allows you to expand functionality for the Building Manager Online 3.0. 

2. Click Purchase Modules. 

 

The purchase modules screen is displayed. 

The purchase modules screen allows you to locate a Leviton representative or distributor in your area. 

Expansion modules must be purchased from a Leviton representative or distributor. 

Modules Menu > Purchasing Buildings 
The last menu item is Purchase Modules. 

1. This allows you to increase the maximum number of buildings added to the expansion modules 

for the Building Manager Online 3.0. 

2. Click Purchase Modules. 

 

The purchase modules screen is displayed. 
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The purchase buildings screen allows you to locate a Leviton representative or distributor in your area. 

Additional buildings must be purchased from a Leviton representative or distributor. 

Wizards 
The purpose of the Wizards menu is to provide assistance in accessing globally used functions 

throughout the Building Manager Online 3.0. 

Wizards > Add a Hub 
1. Click Wizards 

2. Click Add a Hub. 

 

The Add a Hub screen is displayed. 

 

3. Enter the serial number for the hub. 
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a. To access the serial number for an embedded Hub or embedded HubLite, press the 

menu button, select data upload, then select show serial number, the serial number will 

appear on the LCD screen. 

b. To access the serial number for an EMH hub, remove the lid. The serial number is 

located on the label on the Ethernet port. 

c. To access the serial number for an EMH+. Touch the about icon and scroll down. The 

serial number will be displayed on the LCD screen. 

4. Click the Continue Button 

5. Enter the HUB password on the screen that is displayed. 

 

6. Enter the Hub password set in the upload page of the hub. 

a. Important: Set the channel password on your device prior to adding your device to the 

Building Manager Online 3.0. 

b. If you do not know the hub password, contact the site manager for assistance to access 

the device. 

7. Click the Continue Button. 

8. Enter the name of this HUB on the screen that is displayed. 
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9. Enter a unique name for the Hub. 

10. Click the Continue Button. 

11. Click Yes to select an existing group. 

a. The System Network must contain at least one group to select an existing group. 

 

12. Click No to create a new group. 

a. Enter a name for the group. 
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13. Click the Continue Button. 

14. Click the Save Button. 

15. The Hub will be displayed in the System Network under an existing group or a new group. 

 

Wizards > Share a Hub 
1. Click Wizards. 

2. Click Share a HUB. 
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 The Share a HUB screen allows you to select a hub, assign a temporary password to the hub and 

then share the serial number and temporary password with another Building Manager Online 

3.0 user. 

 Sharing allows you to share hub and meter data with another user without granting them full 

access to your hub. 

 The shared user will not be able to edit the configuration settings for the shared hub. 

 The Building Manager Online 3.0 will store one temporary shared password per hub. 

 When a temporary shared password is changed the shared user no longer has data access to the 

shared hub. 

 

3. Select the serial number for the hub you would like to share. 

 

4. Click the Continue button. 
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5. Enter the Hub password set in the upload page of the hub. Important: Set the channel password 

on your device prior to adding your device to the Building Manager Online 3.0. 

a. If you do not know the hub password, contact the site manager for assistance to access 

the device. 

6. Click the Continue button. 

 

7. Enter the share password for the hub. 

a. Once again, this is a temporary password assigned to a hub that allows you to share the 

hub with another Building Manager Online 3.0 user. 

b. If a shared password is assigned to this hub at a later date, the data connection will be 

discontinued for the original share. 

8. Click the Save button 
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Wizards > Remove a Hub 
1. Click Wizards. 

2. Click Remove a Hub. 

 

This option allows you to remove a hub from a group. 

3. Select the serial number. 

 

4. Click the Continue button. 



Using Building Manager Online 3.0 

226 | P a g e  

 

5. Click the “I have read and understand…” checkbox. 

6. Click the Delete button. 

Wizards > Edit a Group 
1. Click Wizards. 

2. Click Edit a Group. 

 

3. Select the Group. 
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4. Click the Continue button. 

 

5. Enter a new name for the group. 

6. Click the Continue button. 

 

7. Click the Save button. 
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Wizards > Remove a Group 
Note: In order to remove a group, the group cannot contain hubs. 

1. Locate the group in the System Network. 

2. Click on the group and see if any hubs are attached. 

 

3. If the group contains hubs, remove the hubs and then proceed. 

 

4. Click Wizards. 

5. Click Remove a Group. 
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Select the Group screen is displayed. 

6. Click the Cancel button to discard changes. 

7. Click the Continue button to proceed to the next step. 

 

Are you sure you want to Delete the Device Group screen is displayed. 
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8. Click the Back button to return to the previous step OR 

9. Click the Cancel button to discard changes OR 

10. Click the Delete button. 

Wizards > Remove a device from a Hub 
1. Click Wizards. 

2. Click Remove a device from a HUB. 

 

The remove device screen allows you to remove a device from a hub. 

Note: The remove device screen allows you to purge all data in the Building Manager Online 3.0 for a 

selected device. This will not physically remove the device from the hub. If the device has not been 

physically disconnected from the hub, the next time the hub communicates/uploads data to the Building 

Manager Online 3.0, the removed device will be added with fresh data. 

3. Select the Group, Hub, and Device. 
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4. Click the Cancel button to discard changes. 

5. Click the Continue button to proceed to the next step. 

Acknowledge Warning and Accept screen is displayed. 

 

6. Click the “I have read and understand…” checkbox. 

7. Click the Back button to return to the previous step OR 

8. Click the Cancel button to discard changes OR 

9. Click Remove Device to remove the device. 

Wizards > Virtual Meters 
This menu item is visible after purchasing the Code Compliance module, the Executive Reporting 

module, or the Tenant Billing module. 
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1. Click Wizards. 

2. Click Virtual Meters. 

 

The Virtual Meters list screen is displayed. From this screen you can add, edit, activate or deactivate a 

virtual meter. 

 

Wizards > Buildings 
This menu item is visible after purchasing the Code Compliance module, the Executive Reporting 

module, or the Tenant Billing module. 

1. Click Wizards. 

2. Click Buildings. 
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The Buildings list screen is displayed. 

 

Wizards > Building Portfolios 
This menu item is visible after purchasing the Executive Reporting module. 

1. Click Wizards. 

2. Click Building Portfolios. 
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The Building Portfolios list screen is displayed. 

 

Wizards > Tenants 
This menu item is visible after purchasing the Tenant Billing module. 

1. Click Wizards. 

2. Click Tenants. 
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The Tenants list screen is displayed. From this screen you can add and edit tenants. 

 

Wizards > Tariffs 
This menu item is visible after purchasing the Tenant Billing module. 

1. Click Wizards. 

2. Click Tariffs. 
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The Tariffs list screen is displayed. From this screen you can add and edit tariffs. 

Wizards > Executive Reporting Alerts 
1. This menu item is visible after purchasing the Executive Reporting module. 

2. Click Wizards. 

3. Click Executive Reporting Alerts. 

 

Executive Reporting Alerts list screen is displayed. 

 

Wizards > Executive Reporting Contacts  
This menu item is visible after purchasing the Executive Reporting module. 

1. Click Wizards. 

2. Click Executive Reporting Contacts. 
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The Executive Reporting Contacts list screen is displayed. 

 

Wizards > Executive Reporting Base Case 
This menu item is visible after purchasing the Executive Reporting module. 

1. Click Wizards. 

2. Click Executive Reporting Base Case. 
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The Executive Reporting Base Cases list screen is displayed. 

 

Wizards > Executive Reporting Building Goals 
This menu item is visible after purchasing the Executive Reporting module. 

1. Click Wizards. 

2. Click Executive Reporting Building Goals. 
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The building goal list screen is displayed. 

 

Wizards > Code Compliance Setup 
This menu item is visible after purchasing the Code Compliance module. 

1. Click Wizards. 

2. Click Code Compliance Setup. 
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The Code Compliance Module Setup screen is displayed. 

 

Account Profile 

Profile > License 
This is the user information screen containing email, phone number, address, etc. that can be edited as 

necessary. 

1. Click Profile. 
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The Profile menu has three items. The first menu item is License. 

2. Click License. 

 

The user licenses screen is displayed. 

 

 The user licenses screen lists all of the licenses purchased for the Building Manager Online 3.0. 

 The Base module license is free of charge. All other additional modules must be purchased to 

use.  

Base Module > Profile > My Profile 
The second menu item is My Profile. 

1. Click My Profile. 
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The user profile screen is displayed. 

 

The user profile screen has three menu items.  

 

Note: A fourth menu item becomes visible after purchasing the Executive Reporting module. 

 

Profile > My Profile > View 
The first menu item is view profile. 
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The user profile screen is the default screen. The user profile screen displays the contact information for 

the Building Manager Online 3.0 account. 

 

Profile > My Profile > Change Password 
The second menu item is Password. 

 

1. Click Password. 

The change password screen is displayed. The change password screen displays the Building Manager 

Online 3.0 account login name and the Building Manager Online 3.0 account email address. 

2. Enter your current password. 
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a. If you have forgot your current password, click Profile > click Logout > click Forgot 

Password? 

 

b. Enter your email address. 

c. Click Reset. 

d. You will receive an email with instructions for signing in and updating your password. 

3. Enter your new password. 

4. Re-enter your new password in the confirm new password field. 

5. Click the Undo button to clear the fields OR 

6. Click the Save button to save the change. 

Profile > My Profile > Edit Profile 
The third menu item is edit profile. 
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1. Click Edit. 

2. The edit profile screen is displayed. 

 

The edit profile screen allows you to modify your profile information. Note: Login Name cannot be 

modified. 

3. Click in the field to be modified. 

4. Enter changes. 

5. Click the Undo button or simply navigate out of the screen without clicking the Save button to 

discard changes OR 

6. Click the Save button to save changes. 

Profile > My Profile > Share Dashboard 
Share Dashboard is the fourth menu item. Note: This fourth menu item becomes visible after purchasing 

the Executive Reporting module. 

 

1. Click Share Dashboard. 

The share dashboard screen is displayed. 
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The share dashboard screen allows you to grant other Building Manager Online 3.0 users with view 

access to your Executive dashboard. 

Profile > My Profile > Share Dashboard > Add a User 
1. Enter an email address into the User E-mail field. 

2. Click the Share button. 

 

3. Click Cancel if you do not want to proceed OR 

4. Click OK to share your Executive Dashboard. 

 

 If the entered email address is not associated with a Building Manager Online 3.0 account, you 

will receive an error message and the email address will not be added to the table in the share 

dashboard screen. 

 If the entered email address is associated with a Building Manager Online 3.0 account, you will 

receive a confirmation message and the shared account will display in the table in the share 

dashboard screen. 

Profile > My Profile > Share Dashboard > Remove a User 
The users you are sharing your Executive Dashboard will be listed in the table in the body of the Share 

Dashboard screen. 

1. Each user will have an Unshare icon to the right of their email address. 
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2. Click the Unshare icon. 

 

The user share is now removed from the dashboard. 

 

Profile > My Profile > Go to Contact Points 
This button is visible after purchasing the Executive Reporting module. 

 

1. Click the Go to Contact Points button. 

 

The Executive Reporting Alerts: Contact Points list screen is displayed. 
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From this page the user can set up multiple addresses for alerts, or edit/delete addresses currently 

entered. 

Profile > Log Out 
1. Click Profile. 

2. Click Log Out. 
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You are now signed out of the Building Manager Online 3.0. 
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